Oracle® Business Process Management
Oracle BPM Enterprise Configuration Guide
10g Release 3 (10.3.1)

January 2009
Contents

Introduction .........................................................................................................................5
  Document Scope and Audience ..................................................................................................5
  Oracle Documentation and Resources ..........................................................................................5

Getting Started ...................................................................................................................7
  Installation Prerequisites ...............................................................................................................7
  Required Usernames and Passwords .............................................................................................7
  Configuration Overview ..................................................................................................................8

Configuring Oracle BPM Enterprise Standalone .................................................................9
  Creating a New Directory Service ..................................................................................................9
  Deploying and Publishing a New BPM Project .........................................................................11
  Creating a Process Execution Engine .......................................................................................11

Configuring Oracle BPM Enterprise on J2EE .....................................................................13
  Creating a New Directory Service ...............................................................................................13
  Creating a Process Execution Engine .......................................................................................15
  Configuring WebLogic Server ....................................................................................................15
    Creating a Oracle WebLogic Server Domain .............................................................................16
    Creating Oracle BPM Deployer User .......................................................................................16
    Installing the Oracle BPM Deployer ......................................................................................17
    Creating JDBC Data Sources on WebLogic Server ................................................................17
    Creating a JMS Server .............................................................................................................18
    Creating a JMS Module ............................................................................................................19
    Creating JMS Resources .........................................................................................................19
    Disabling Server Affinity for Connection Factories ................................................................20
    Configuring the Deployer and Deployment Targets ............................................................20
  Configuring WebSphere Application Server ...........................................................................21
    Installing Oracle BPM Deployer ............................................................................................21
    Adding Authentication Data for JDBC ....................................................................................22
    Creating a New JDBC Provider ..............................................................................................23
    Creating a JDBC Datasource for Directory Database ..........................................................24
    Creating a JDBC Datasource for the Engine Database .......................................................25
    Creating a WebSphere JMS Bus .............................................................................................26
    Creating JMS Resources ........................................................................................................27
    Configuring a Work Manager ...............................................................................................29
    Configuring JVM Properties .................................................................................................30
    Restarting WebSphere Servers .............................................................................................30
    Setting Oracle BPM properties for WebSphere ..................................................................30
    Preparing Oracle BPM Applications ..................................................................................31
    Enabling Clustering ...............................................................................................................31
    Building and Deploying Application EAR Files ..................................................................32
    Deploying and Publishing a New BPM Project ....................................................................32
Configuring SSL for Oracle BPM Web Applications ................................................................. 33

Integrating Oracle BPM with Other Oracle Products ................................................................. 34
  Integrating AquaLogic Service Bus .......................................................................................... 34
    Registering a BPM Process on AquaLogic Service Bus ...................................................... 34
  Supported Transport Protocols ............................................................................................... 36
  Integrating Oracle BPM with WebLogic Portal ....................................................................... 36
    Generate the WorkSpace Application .................................................................................. 37
    Creating a Participant Using Process Administrator ......................................................... 37
    Deploying the WAR File in WebLogic Portal ..................................................................... 38
    Importing the Login Portlet ................................................................................................. 40
    Creating a New Portal ......................................................................................................... 40
    Verifying your Installation ................................................................................................. 41
  Integrating Oracle BPM with AquaLogic Interaction .............................................................. 42
    Running the WorkSpace Extension Configuration Wizard ................................................. 42
    Deploying the .pte File ........................................................................................................ 43
    Assigning Process Administrators ..................................................................................... 43
    Configure Oracle BPM Enterprise ...................................................................................... 43
    Verifying Your Installation ................................................................................................. 44

Integrating Oracle BPM with AquaLogic Interaction .............................................................. 42
  Running the WorkSpace Extension Configuration Wizard ................................................. 42
  Deploying the .pte File ........................................................................................................ 43
  Assigning Process Administrators ..................................................................................... 43
  Configure Oracle BPM Enterprise ...................................................................................... 43
  Verifying Your Installation ................................................................................................. 44

Configuring Oracle BPM with AquaLogic Interaction .............................................................. 42
  Running the WorkSpace Extension Configuration Wizard ................................................. 42
  Deploying the .pte File ........................................................................................................ 43
  Assigning Process Administrators ..................................................................................... 43
  Configure Oracle BPM Enterprise ...................................................................................... 43
  Verifying Your Installation ................................................................................................. 44

Configuring Oracle BPM Supporting Applications ............................................................... 46
  Process Instance Archiving ................................................................................................. 46
  Archiving and Deployment ................................................................................................. 46
  Configuring Archiving ........................................................................................................ 46
  BAM ....................................................................................................................................... 47
    BAM Overview ................................................................................................................ 47
    Configuring BAM .............................................................................................................. 47
    Process Data Mart Overview ............................................................................................ 56
    Configuring Process Data Mart ......................................................................................... 56
  Configuring WorkSpace Across Multiple Domains ............................................................... 58

Reference ................................................................................................................................... 60
  Engine and Directory Database Connectivity ...................................................................... 60
    Oracle Driver Properties ................................................................................................ 60
    Oracle DB2 Driver Properties .......................................................................................... 61
    Oracle SQL Server Driver Properties ............................................................................. 62
    Oracle Sybase Driver Properties ...................................................................................... 63
  Oracle BPM Configuration Wizard Reference .................................................................... 64
    Oracle BPM Configuration Wizard Overview ................................................................ 64
    Running the Oracle BPM Configuration Wizard .............................................................. 64
    Running the Configuration Wizard Silently ...................................................................... 66
    Oracle BPM Configuration Wizard Reference ................................................................ 66
    Configuration Wizard Template File ................................................................................ 79
Introduction

This section provides general information about the Oracle BPM Configuration Guide. This guide assumes that you have already installed Oracle BPM Enterprise. See the Oracle BPM Installation Guide for more information.

Document Scope and Audience

This document is written for system administrators who need to configure Oracle BPM Enterprise. It focuses primarily on the tasks required to configure various components of Oracle BPM Enterprise. It provides procedures for configuring the standalone and J2EE versions. It also provides procedures for integrating Oracle BPM with other Oracle products, including AquaLogic Interaction and WebLogic Portal.

This guide also provides general information about Oracle BPM Enterprise, including general product and architectural information.

This document assumes that you are familiar with system and enterprise application administration. If you are configuring Oracle BPM Enterprise on J2EE, it assumes that you are familiar with web application server technology and have an understanding of how to install, configure, and administer your web application server.

Oracle Documentation and Resources

This section describes other documentation, resources, support, and training information provided by Oracle.

The table below lists a number of Oracle Documentation and Resources which will help you get started with Oracle BPM.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle BPM Documentation</td>
<td>The complete Oracle BPM 10.3 product documentation is available at</td>
</tr>
<tr>
<td>Oracle BPM Product Page</td>
<td>The official BPM product page is available at</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oracle.com/technology/products/bpm/index.html">http://www.oracle.com/technology/products/bpm/index.html</a> and provides news,</td>
</tr>
<tr>
<td></td>
<td>data sheets and useful links.</td>
</tr>
<tr>
<td>Oracle BPM Download Page</td>
<td>You can download the latest version of Oracle BPM from</td>
</tr>
<tr>
<td>Online Help</td>
<td>To access online help:</td>
</tr>
<tr>
<td></td>
<td>• In BPM Studio, select Help ➤ Help Contents to access the complete</td>
</tr>
<tr>
<td></td>
<td>Oracle BPM Studio help. Context help is also available by pressing the</td>
</tr>
<tr>
<td></td>
<td>F1 key, or by selecting Help ➤ Dynamic Help from the menu.</td>
</tr>
<tr>
<td></td>
<td>• In BPM WorkSpace, click on Help in the title bar, or click on the help icon</td>
</tr>
<tr>
<td></td>
<td>( hovered) in the title bar of any panel for help about that panel.</td>
</tr>
<tr>
<td>Oracle Technology Network (OTN)</td>
<td>The Oracle Technology Network features articles, blogs, and newsgroups</td>
</tr>
<tr>
<td></td>
<td>which will help you make the most out of Oracle products.</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.oracle.com/technology/index.html">http://www.oracle.com/technology/index.html</a></td>
</tr>
<tr>
<td>Resource</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Technical Support</td>
<td>If you cannot resolve an issue using the above resources, Oracle Technical Support is happy to assist. <a href="http://www.oracle.com/support/index.html">http://www.oracle.com/support/index.html</a></td>
</tr>
</tbody>
</table>
Getting Started

The following topics provide general information that you may need to know before configuring Oracle BPM Enterprise. These sections include a general overview of the Oracle BPM Enterprise architecture and a list of pre-installation requirements you must perform before configuration.

Installation Prerequisites

Before configuring Oracle BPM Enterprise, you should ensure that you have completed the configuration prerequisites described below.

<table>
<thead>
<tr>
<th>Prerequisite</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install Oracle BPM Enterprise</td>
<td>Before performing the configuration and integration procedures, ensure that you have installed Oracle BPM as outlined in the <em>Oracle BPM Installation Guide</em>.</td>
</tr>
<tr>
<td>Install your database server</td>
<td>Before configuring Oracle BPM, ensure that you have installed your database server. A basic Oracle BPM Enterprise installation requires an external database for the engine and directory service databases. If you are configuring the BAM and Process Data Mart applications, each of these require a database. See your database vendor documentation for more information.</td>
</tr>
<tr>
<td>Install your application server</td>
<td>If you are configuring Oracle BPM on J2EE, ensure that you have installed and configured your application server. See your application server vendor’s documentation for more information.</td>
</tr>
<tr>
<td>Install other Oracle Products</td>
<td>If you are integrating Oracle BPM with other Oracle products, ensure that these products are installed and configured.</td>
</tr>
</tbody>
</table>

Required Usernames and Passwords

When configuring Oracle BPM Enterprise, there are multiple usernames and passwords that you must configure or use. These are used to connect to the various systems Oracle BPM uses.

<table>
<thead>
<tr>
<th>Username and Password</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Database Administrator</td>
<td>The DBA username and password to connect to the engine database. If you do not have DBA access to the database server, you can generate the SQL commands that can be given to your DBA.</td>
</tr>
<tr>
<td>Directory Database Administrator</td>
<td>The DBA username and password to connect to the directory database. If you do not have DBA access to the database server, you can generate the SQL commands that can be given to your DBA.</td>
</tr>
</tbody>
</table>
### Configuration Overview

This guide provides procedures and scenarios for configuring both the standalone and J2EE versions of Oracle BPM Enterprise. It also provides information on integrating Oracle BPM with other Oracle products. The following sections outline the different configuration scenarios provided in this guide.

**Note:** The following table lists the appropriate section of this guide for different configuration and integration tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Oracle BPM Enterprise Standalone</td>
<td><a href="#">Configuring Oracle BPM Enterprise Standalone</a> on page 9</td>
</tr>
<tr>
<td>Integrating Oracle BPM with WebLogic Portal</td>
<td><a href="#">Integrating Oracle BPM with WebLogic Portal</a> on page 36</td>
</tr>
<tr>
<td>Integrating Oracle BPM with Oracle User Interaction</td>
<td><a href="#">Integrating Oracle BPM with AquaLogic Interaction</a> on page 42</td>
</tr>
</tbody>
</table>
Configuring Oracle BPM Enterprise Standalone

The following sections describe how to configure Oracle BPM Enterprise Standalone.

Before you begin configuring Oracle BPM Enterprise, ensure that you have reviewed Configuration Overview on page 8 and Installation Prerequisites on page 7 to determine what needs to be done before you begin and the order you need to perform the following procedures.

1. Review Configuration Prerequisites
   See Installation Prerequisites on page 7. This topic provides information about the required software you must install before using this guide.

2. Create an Organization
   If you are configuring Oracle BPM in a production environment, you should ensure that you have created and configured your organizational structure before deploying and publishing a project. However, if you are creating a test environment, this is not required.
   See the Oracle BPM Enterprise Administration Guide for more information on creating an organization.

3. Configure a Directory Service
   The directory service is what allows you to connect projects deployed on Oracle BPM Enterprise with your organization.

4. Deploy a Project
   After creating a directory structure, you are ready to deploy a project.

5. Test Your Configuration
   To test your configuration you should login to the WorkSpace application as an Oracle BPM Administrator or using the login and password of a participant in your process.

Creating a New Directory Service

If you are planning to use a database-only directory service, you need to install and configure only a relational database. If you are planning to use a hybrid directory service, you need to install and configure both a relational database and an LDAP server.

If you are integrating Oracle BPM with AquaLogic Interaction, refer to Configure Oracle BPM Enterprise on page 43 for details on how to configure the BPM directory service.

To create a Directory Service, you use the Oracle BPM Configuration Wizard within the Oracle BPM Admin Center.

Note: The exact path you follow in the Configuration Wizard depends on whether you are configuring a database-only or hybrid directory service.

Note: If you are creating this directory service as part of a new installation, you can also use the Oracle BPM Configuration Wizard to configure the Process Execution Engine database.

1. Launch the Oracle BPM Admin Center
2. Click Configuration
   The Configuration window appears.
4. Click Add.
The Configuration Wizard Tasks window appears.

5. Select **Create Directory Service**, and then click **Next**.
The Directory Provider Type window appears.

The Directory Provider Type window enables you to choose the type of directory service:

- **A database managed by Oracle BPM.** Selecting this option configures a directory service consisting of a relational database only.
- **An external directory service provider plus a relational database.** This configuration is also called a hybrid directory service. Selecting this option indicates that configuration information for the project is to be stored in the relational database, and participant identity information—including security credentials, roles and permissions, groups, and organizational units—is to be stored in one of the supported LDAP directories. You must specify this option if integrating with AquaLogic Interaction (see *Configure Oracle BPM Enterprise* on page 43 for details).

6. Select the type of directory provider type, and then click **Next**.
The Directory Provider Selection window appears.

If you chose to configure a database managed by Oracle BPM, the Directory Provider Selection window prompts you to specify:

- The Directory Provider, that is, the relational database for the directory service. For information about supported directory providers and the parameters you must configure for each one, see *Engine and Directory Database Connectivity* on page 60.
- The user identifier and password for the BPM Administrator User. These are the credentials the Process Administrator retrieves when authenticating the Oracle BPM administrator.

  📜 **Note:** Once a directory is created with the respective directory.xml file, the BPM Administrator cannot be changed.

If you choose to create a hybrid directory service, the Directory Provider Selection window also prompts you to specify the organization provider, that is, an one of the supported LDAP directories.

7. Select the organization provider and click **Next**.
The Configure Directory Provider window prompts you for the connectivity information for the directory provider database. The information required depends on the database—such as DB2, MS SQL, or Oracle. To learn more about the connectivity information you need to enter, see *Engine and Directory Database Connectivity* on page 60.

8. Enter the connectivity information and click **Next**.
The Enter Directory Creation window prompts you for:

- The username and password of the database administrator
- The logical name of the organization for this environment. This symbolic name is used in contexts where processes in different environments communicate with each other.

After the Configuration Wizard runs successfully, your newly created directory service appears on the **Directory** tab page of the Configuration Wizard.

See *Configuring Organization using a DB-Only Directory Service* for information on creating an organization if you are using a database-only directory service.

See *Configuring a Hybrid Directory Service* for information on configuring a hybrid directory service.
Deploying and Publishing a New BPM Project

This task outlines the procedures for deploying and publishing a new project using the Process Administrator. See Creating a Project Version if you are publishing and deploying a new version of an existing project.

1. Launch the Process Administrator
2. Click Projects
3. Click Publish
   The Publication Source pane appears
4. Select the Publication Source

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project at Web Server Host</td>
<td>Allows you to select a BPM Project from the file system of the server where the Process Administrator is running.</td>
</tr>
<tr>
<td>Exported Project</td>
<td>Allows you to select an exported BPM Project from the file system of the local computer where your web browser is running.</td>
</tr>
</tbody>
</table>

5. Select Deploy processes after publishing them.
6. Click OK.
   The Publish Process pane appears.
7. Expand Role Mapping.
8. Map the Roles
9. Click Publish.
   The Deployment Topology pane appears.
10. Click OK.
    To perform a basic deployment of a project, use the default values for these fields.

Your project appears in the list of deployed projects.

Creating a Process Execution Engine

Using Process Administrator, you can create a new Process Execution Engine.

Before creating a new Process Execution Engine, ensure that your engine database server is configured and running. When creating a new engine, Process Administrator connects to the database and creates the required database tables.

1. Launch Process Administrator
2. Click Engines.
3. Click Add.
4. Enter the following information for your new engine:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Name</td>
<td>Defines the name of the engine</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Engine Type</td>
<td>Specifies the type of engine. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Enterprise</td>
</tr>
<tr>
<td></td>
<td>• J2EE</td>
</tr>
<tr>
<td>Note:</td>
<td>When using the Oracle BPM Standalone, you can only create an engine of type Enterprise. When using the J2EE version, you can create either type.</td>
</tr>
</tbody>
</table>

**Engine Database Type** Specifies the database driver the engine uses.

5. Click Next.
6. Select the database driver for your engine database vendor.
7. Enter the connectivity information for your engine database.
   See [Engine and Directory Database Connectivity](#) on page 60 for information on supported database types.
8. Click Next.
   The **Engine Configuration** page appears. From this page you can edit additional engine properties before you create the engine. See [Engines](#) page allows you to create, configure, and manage Process Execution Engines. for information on additional engine properties.
9. Click Save to create the Process Execution Engine.
The following sections describe how to configure the Oracle BPM Enterprise core applications on J2EE. It contains specific procedures for Oracle WebLogic Server.

Before you begin configuring Oracle BPM Enterprise, ensure that you have reviewed Configuration Overview on page 8 and Installation Prerequisites on page 7 to determine what needs to be done before you begin and the order you need to perform the following procedures.

1. Review Configuration Prerequisites
   See Installation Prerequisites on page 7. This topic provides information about the required software you must install before using this guide.

2. Create an Organization
   If you are configuring Oracle BPM in a production environment, you should ensure that you have created and configured your organizational structure before deploying and publishing a project. However, if you are creating a test environment, this is not required.
   See the Oracle BPM Enterprise Administration Guide for more information on creating an organization.

3. Configure a Directory Service
   The directory service is what allows you to connect projects deployed on Oracle BPM Enterprise with your organization.

4. Configure your J2EE application server
   - If you are configuring Oracle WebLogic Server see Configuring WebLogic Server on page 15.

5. Configure the Deployer
   Configuring the Deployer and Deployment Targets on page 20

6. Enable clustering
   Enabling Clustering on page 31

7. Build and deploy application EAR Files
   Building and Deploying Application EAR Files on page 32

8. Create a Process Execution Engine

9. Deploy and Publish your Oracle BPM project.
   Deploying and Publishing a New BPM Project on page 32

---

### Creating a New Directory Service

If you are planning to use a database-only directory service, you need to install and configure only a relational database. If you are planning to use a hybrid directory service, you need to install and configure both a relational database and an LDAP server.

If you are integrating Oracle BPM with AquaLogic Interaction, refer to Configure Oracle BPM Enterprise on page 43 for details on how to configure the BPM directory service.

To create a Directory Service, you use the Oracle BPM Configuration Wizard within the Oracle BPM Admin Center.
Note: The exact path you follow in the Configuration Wizard depends on whether you are configuring a database-only or hybrid directory service.

Note: If you are creating this directory service as part of a new installation, you can also use the Oracle BPM Configuration Wizard to configure the Process Execution Engine database.

1. Launch the Oracle BPM Admin Center
2. Click Configuration
   The Configuration window appears.
4. Click Add.
   The Configuration Wizard Tasks window appears.
5. Select Create Directory Service, and then click Next.
   The Directory Provider Type window appears.
   The Directory Provider Type window enables you to choose the type of directory service:
   • A database managed by Oracle BPM. Selecting this option configures a directory service consisting of a relational database only.
   • An external directory service provider plus a relational database. This configuration is also called a hybrid directory service. Selecting this option indicates that configuration information for the project is to be stored in the relational database, and participant identity information—including security credentials, roles and permissions, groups, and organizational units—is to be stored in one of the supported LDAP directories. You must specify this option if integrating with AquaLogic Interaction (see Configure Oracle BPM Enterprise on page 43 for details).
6. Select the type of directory provider type, and then click Next.
   The Directory Provider Selection window appears.
   If you chose to configure a database managed by Oracle BPM, the Directory Provider Selection window prompts you to specify:
   • The Directory Provider, that is, the relational database for the directory service. For information about supported directory providers and the parameters you must configure for each one, see Engine and Directory Database Connectivity on page 60.
   • The user identifier and password for the BPM Administrator User. These are the credentials the Process Administrator retrieves when authenticating the Oracle BPM administrator.
     Note: Once a directory is created with the respective directory.xml file, the BPM Administrator cannot be changed.

If you choose to create a hybrid directory service, the Directory Provider Selection window also prompts you to specify the organization provider, that is, an one of the supported LDAP directories.

7. Select the organization provider and click Next.
   The Configure Directory Provider window prompts you for the connectivity information for the directory provider database. The information required depends on the database—for example, DB2, MS SQL, or Oracle. To learn more about the connectivity information you need to enter, see Engine and Directory Database Connectivity on page 60.

8. Enter the connectivity information and click Next.
   The Enter Directory Creation window prompts you for:
   • The username and password of the database administrator
   • The logical name of the organization for this environment. This symbolic name is used in contexts where processes in different environments communicate with each other.
After the Configuration Wizard runs successfully, your newly created directory service appears on the Directory tab page of the Configuration Wizard.

See Configuring Organization using a DB-Only Directory Service for information on creating an organization if you are using a database-only directory service.

See Configuring a Hybrid Directory ServiceThis high-level task demonstrates how to configure a hybrid directory service using Process Administrator. for information on configuring a hybrid directory service.

Creating a Process Execution Engine

Using Process Administrator, you can create a new Process Execution Engine.

Before creating a new Process Execution Engine, ensure that your engine database server is configured and running. When creating a new engine, Process Administrator connects to the database and creates the required database tables.

1. Launch Process Administrator
2. Click Engines.
3. Click Add.
4. Enter the following information for your new engine:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Name</td>
<td>Defines the name of the engine</td>
</tr>
<tr>
<td>Engine Type</td>
<td>Specifies the type of engine. Valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Enterprise</td>
</tr>
<tr>
<td></td>
<td>• J2EE</td>
</tr>
</tbody>
</table>

⚠️ Note: When using the Oracle BPM Standalone, you can only create an engine of type Enterprise. When using the J2EE version, you can create either type.

5. Click Next.
6. Select the database driver for your engine database vendor.
7. Enter the connectivity information for your engine database.
   See Engine and Directory Database Connectivity on page 60 for information on supported database types.
8. Click Next.
   The Engine Configuration page appears. From this page you can edit additional engine properties before you create the engine. See EnginesThe Engines page allows you to create, configure, and manage Process Execution Engines. for information on additional engine properties.
9. Click Save to create the Process Execution Engine.

Configuring WebLogic Server

The following sections outline the procedures for installing Oracle BPM on Oracle WebLogic Server. They describe how to perform a manual configuration for a single server or clustered environment. If you are configuring a production environment, it is recommended that you follow these procedures.
If you are creating a testing environment with a single server installation, you can use the Oracle BPM Configuration Wizard. See Oracle BPM Configuration Wizard Reference on page 64 for more information.

Creating a Oracle WebLogic Server Domain

A domain is the basic administration unit for WebLogic Server instances. A domain consists of one or more WebLogic Server instances (and their associated resources) that you manage with a single Administration Server. To configure Oracle BPM on WebLogic Server, you must have a working WebLogic Server domain.

See Configuring and Managing WebLogic Server for more information on WebLogic Server domains.

The following procedures show you how to use the WebLogic Server Configuration Wizard to create a new domain configuration. However, there are other tools you can use to create a new WebLogic Server domain including the Oracle BPM Configuration Wizard. See Oracle BPM Configuration Wizard Reference on page 64

1. Launch the WebLogic Server Configuration Wizard
   See Creating WebLogic Domains Using the Configuration Wizard for more information.

2. Create your domain configuration using the WebLogic Server Configuration Wizard.
   You can use this wizard to create multiple managed servers and cluster depending on the requirements for your environment.

After creating your new domain configuration, you should start the Administration Server and each managed server to verify that everything has been configured successfully.

Creating Oracle BPM Deployer User

Before deploying the Oracle BPM Deployer application, you must create a WebLogic Server user with Administration privileges. The Oracle BPM Deployer application uses this user to install and manage applications on WebLogic.

1. Launch the WebLogic Server Administration Console.
2. Click on Security Realms.
3. Select the security realm where you want to create the new user.
   The default security realm is myrealm.
4. Click Users and Groups
5. Click New.
6. Enter the following information

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name of the user. You must specify FuegoWebLogicDeployer.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for this user.</td>
</tr>
</tbody>
</table>

7. Click OK
   The new user appears in the list of users defined for this security realm.
8. Select the FuegoWebLogicDeployer user.
9. Select the Groups tab.
10. Add the Administrator groups to the user.
11. Click Save.
12. Click Activate Changes when you are finished.
Installing the Oracle BPM Deployer

The Oracle BPM Deployer is a J2EE application that simplifies the procedures for deploying, starting, and stopping the Oracle BPM web applications using J2EE.

The Oracle BPM Deployer acts as a bridge between the web application server and the Oracle BPM Process Administrator. Using the Oracle BPM deployer you can use the Process Administrator to control your web applications without using the administration console of your application server.

1. Launch the WebLogic Server Administration Console.
2. If you have not done so, click Lock and Edit.
3. Select Deployments.
4. Select Install.
5. Browse to the location of the Deployer EAR file.
   The default location is: `<ORABPM_HOME>/j2ee/weblogic/deployer`
6. Select `wlj2eedeployer.ear`
7. Click Next
8. Select Install this deployment as an application.
9. Click Next
10. Select the Administration Server as the deployment target
    
    Note: You must target the Deployer to the administration server.
11. Click Next.
12. Click Finish.
    After deployment, the `wlj2eedeployer` application appears in the list of deployments for the administration server.
13. Select Activate Changes.
    a) Select Deployments.
    b) Click the checkbox next to `wlj2eedeployer`
    c) Select Start ➤ Servicing all requests
    d) Click Yes
    The status of the `wlj2eedeployer` application shows active.

Creating JDBC Data Sources on WebLogic Server

To use Oracle BPM Enterprise on WebLogic Server, you must configure two JDBC data sources. These data sources allow the Process Execution Engine to connect to the Engine and Directory databases.

The following procedures show you how to create JDBC data sources using the WebLogic Server Administration Console. See Configuring and Managing WebLogic JDBC for more information.

Note: You must perform the following procedures twice to create two separate JDBC data sources for the Engine and Directory databases. These data sources must have the following names and JNDI names:

<table>
<thead>
<tr>
<th>Database</th>
<th>Data Source Name</th>
<th>JNDI Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Database</td>
<td>BPMServerDS</td>
<td>XAEngineDS</td>
</tr>
<tr>
<td>Directory Database</td>
<td>FDIDS</td>
<td>FDIDS</td>
</tr>
</tbody>
</table>

1. Launch the Administration Console
2. In the **Domain Structure** tree, expand **Services ➤ JDBC**
3. Select **Data Sources**.
4. Click **New** on the Summary of Data Sources page.
5. Enter or select the following information

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of your JDBC data source. The data source name provided here must correspond to the required names for the Engine and Directory databases.</td>
</tr>
<tr>
<td>JNDI Name</td>
<td>The JNDI name of this data source. The JNDI name provided here must correspond to the required JNDI names for the Engine and Directory databases.</td>
</tr>
<tr>
<td>Database Type</td>
<td>Specifies the vendor of your directory and engine databases.</td>
</tr>
<tr>
<td>Database Driver</td>
<td>Specifies the JDBC driver version used by this data source.</td>
</tr>
</tbody>
</table>

**Note:** You must select a driver that supports transactions.

6. Click **Next**.
   The Transaction Options screen appears.
7. Provide the connectivity properties for your database.
   The specific information you must provide depends on your database vendor.
8. Click **Next**
   The Test Database Connection page appears.
9. Click **Test Configuration** to verify that your JDBC data source is configured correctly.
   Although this step is not required, it is important to verify that the connectivity information you provided is correct.
10. Click **Next**.
11. Select the targets where you want to deploy your JDBC data source.
    **Note:** You MUST target each data source to all managed servers within each cluster.
12. Click **Finish**.
   Your new JDBC data source appears in the list of data sources on the Summary of JDBC Data Sources page.

**Creating a JMS Server**

When running on WebLogic Server, Oracle BPM Enterprise uses JMS to synchronize and communicate between different components. A JMS Server functions as a management container for resources within JMS Modules.

See *Configuring and Managing WebLogic JMS* for more information on using JMS in WebLogic Server.

The following procedures show you how to configure JMS servers using the WebLogic Administration Console.

**Note:** You must create a different JMS Server for each managed server in your environment.
1. Click **Lock and Edit**
2. Expand **Services ➤ Messaging**
3. Select **JMS Servers**.
4. Click **New**.
5. Enter a name for your JMS Server
6. Click **Next**.
7. Select the managed server where you want to target this JMS Server
8. Click **Finish**.

Your new JMS Server appears in the list of JMS servers. You should ensure that you have one JMS server targeted to each managed server in your cluster.

After you create a JMS Server, you must create and configure a JMS System Modules and JMS Resources managed by this server.

### Creating a JMS Module

JMS Modules are application-related definitions that are independent of the domain environment. Oracle BPM requires you to create a JMS system module that is targeted to each managed server within a cluster.

JMS System modules are created at the container level as opposed to the applications level. System modules are used to configure JMS resources including queues and topic connections factories. System modules are configured as subdeployments to allow them to be targeted to multiple managed servers.

**Note:** Oracle BPM Enterprise requires that each JMS module is targeted the cluster.

1. Expand **Services ➤ Messaging**
2. Select **JMS Modules**
3. Click **New**.
4. Provide a Name for the new Module
5. Click **Next**
6. Target the new module to the cluster.

**Note:** The module must be targeted to the cluster, not to the managed servers within the cluster.

7. Click **Next**.
8. Click **Finish** to create the JMS system module.

The new JMS system module appear in the list of JMS modules. You can now create the required JMS resources.

### Creating JMS Resources

Within a JMS module, you can define different configuration resources that are targeted to each JMS server.

**Note:** JMS resources must be configured with the same JNDI names required by Oracle BPM Enterprise.

The name and JNDI name of your JMS resources must correspond to the names defined in Process Administrator. The default names and JNDI names are listed in the table below.

**Note:** If you do not use the default names, you must change the values defined in Process Administrator. See the *Oracle BPM Enterprise Administration Guide* for more information.

<table>
<thead>
<tr>
<th>JMS Resource</th>
<th>JNDI Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributed Topic</td>
<td>topic/EngineNews</td>
<td></td>
</tr>
<tr>
<td>Distributed Queue</td>
<td>queue/ToDoQueue</td>
<td></td>
</tr>
</tbody>
</table>
1. Expand Services ➤ Messaging
2. Select JMS Modules.
3. Select the system module you created in the previous task.
4. Click New.
5. Select the type of resource you want to create.
   You must create each of the resources defined in the table above.
6. Click Next.
7. Provide the following properties for your resource:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Specifies the name of your JMS resource. See the table above for the correct names.</td>
</tr>
<tr>
<td>JNDI Name</td>
<td>Specifies the JNDI name for your JMS Resource. See the table above for the correct JNDI name.</td>
</tr>
</tbody>
</table>

8. Click Next.
9. Click Advanced Targeting.
10. Select the subdeployment created in the previous task.
11. Select the JMS Server where you want to target the JMS resources to the cluster.
   ☰ Note: You must target the JMS resources created earlier to the cluster.
12. Click Finish.

Disabling Server Affinity for Connection Factories
You should disable server affinity for each of the connection factory resources required by Oracle BPM
To ensure that Oracle BPM work correctly within a WebLogic Server cluster, you must disable server affinity from the XAConnectionFactory and XATopicConnectionFactory created previously.
1. Click Lock and Edit.
2. Expand Services ➤ Messaging.
3. Select JMS Modules
4. Select the system module where the Oracle BPM connection factories are stored.
5. Select the connection factory.
6. Click the Load Balancing tab.
8. Click Save.
9. Click Activate Changes.

Configuring the Deployer and Deployment Targets
1. Launch the Process Administrator
2. **Select Engines**
3. Select the engine where you want to configure the deployer.
4. Select the **Application Server** tab.
5. Enter the following information:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BPM Application Deployer URL</td>
<td>Specifies the URL of the deployer. The default location is: <a href="http://localhost:7001/fuego/deployer/servlet/worker">http://localhost:7001/fuego/deployer/servlet/worker</a></td>
</tr>
<tr>
<td>Server or Cluster Name</td>
<td>Specifies the name server or cluster target where the Oracle BPM applications are deployed.</td>
</tr>
</tbody>
</table>

After defining the Deployer URL and specifying the target cluster or server, you can use the Process Administrator to deploy the Oracle BPM applications.

### Configuring WebSphere Application Server

The following sections outline the procedures for configuring Oracle BPM on WebSphere Application Server.

**Note:** The following procedures assume that you have already configured your IBM WebSphere Application Server installation. If you are configuring a Oracle BPM to work in a clustered environment, it is assumed your environment contains the following configuration:

- Each node of your cluster is running a separate physical host. This helps to ensure high availability.
- Your cluster is associated with a cell that can be used as a deployment target.

### Installing Oracle BPM Deployer

The Oracle BPM Deployer is a J2EE application that simplifies the procedures for deploying, starting, and stopping the Oracle BPM web applications using J2EE.

The Oracle BPM Deployer acts as a bridge between the web application server and the Oracle BPM Process Administrator. Using the Oracle BPM deployer you can use the Process Administrator to control your web applications without using the administration console of your application server.

**Note:** The Oracle BPM Deployer is only supported on a single-node configuration for IBM WebSphere. If you are configuring Oracle BPM to run in a clustered environment, you can skip this section.

1. **Login to WebSphere’s Administration Console.**
   
   By default, it runs on http://host:9060/ibm/console.

2. **Go to Applications ➤ Install New Applications** and select Oracle BPM Deployer EAR file.

   The Oracle BPM Deployer consists of an EAR file provided with the installation of Oracle BPM Enterprise. It is located under the following directory: `<ORABPM_HOME>/j2ee/websphere/deployer`.

   Two copies are provided. You should pick one depending on whether your WebSphere environment has Global Security enabled:

   - `wasj2eedeployer.ear`: If security is disabled.
   - `wasj2eedeployersecured.ear`: If security is enabled.

   **Note:** If WebSphere’s Administration Console didn’t prompt you for a password at login, it probably means Global Security is disabled.
3. Click **Next** and review the installation options.  
   Accepting the default installation options works for most cases. Always refer to WebSphere’s official documentation for details.

4. Click **Next** and select the WebSphere server where to install Oracle BPM Deployer.  
   On a single-server setup, you must install it on the only server available.
   - **Restriction:** On a clustered WebSphere environment, Oracle BPM Deployer must be installed in the Deployment Manager server (dmgr). WebSphere’s Console may not allow you to pick the Deployment Manager server as a target for installing applications; If this is the case, you must install Oracle BPM Deployer using other means, such as WebSphere's `wsadmin` command-line tool.

5. Click **Next** again, and **Finish** after reviewing all selected options.  
   You should get confirmation that *Fuego WebSphere Deployer* application was successfully installed.

6. Save your WebSphere configuration changes.

7. Go to **Applications ➤ Enterprise Applications** and start Fuego WebSphere Deployer application.

The Oracle BPM WebSphere Deployer is now installed and ready.

### Adding Authentication Data for JDBC

Before creating JDBC datasources, you must define the authentication information for the JDBC connections.

You must create two sets of authentication data: one for the Oracle BPM Directory Database and one for Oracle BPM Engine's back-end database.

- **Note:** The following procedures are applicable to both single-node and clustered configurations.

1. Login to WebSphere’s Administration Console. By default, it runs on `http://host:9060/ibm/console`.
2. Go to **Security ➤ Secure administration, applications and infrastructure**, expand the **Java Authentication and Authorization Service** section on the right pane and click on **J2C authentication data**.
3. Click **New** to create a new entry for Oracle BPM Directory database.

   Enter the following fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>Oracle BPM Directory DB Auth</td>
</tr>
<tr>
<td>User ID</td>
<td><em>The JDBC user id to access Oracle BPM Directory Database.</em></td>
</tr>
<tr>
<td>Password</td>
<td><em>The password for the above user to access Oracle BPM Directory Database.</em></td>
</tr>
</tbody>
</table>

   You must enter the same user id and password you specified when creating the Oracle BPM Directory database using the *Configuration Wizard* *The Configuration Wizard provides an easy way for configuring the Oracle BPM applications.*

4. Click **OK** to save.
5. Click **New** to create a new entry for Oracle BPM Engine database.

   Enter the following fields:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias</td>
<td>Oracle BPM Engine DB Auth</td>
</tr>
<tr>
<td>User ID</td>
<td><em>The JDBC user id to access Oracle BPM Engine Database.</em></td>
</tr>
</tbody>
</table>
The password for the above user to access Oracle BPM Engine Database.

You must enter the same user id and password you specified when creating the Oracle BPM Engine database using the Configuration Wizard The Configuration Wizard provides an easy way for configuring the Oracle BPM applications.

6. Click OK to save.
7. Click on Save to persist your WebSphere configuration changes.

The new J2C authentication data entries are ready to be used from a JDBC Datasource configuration.

Creating a New JDBC Provider
You must create and configure a new JDBC provider to use the JDBC drivers provided by BEA.

1. Login to WebSphere’s administration console.
   By default, the administration console runs at: http://host:9060/ibm/console.
2. Select Resources ➤ JDBC ➤ JDBC Providers
3. Click New to add a new JDBC Provider.
   ▶ Note: You must select a WebSphere configuration scope for your new resources.
   In a single-node configuration, you must select the server node. In a clustered configuration, you must select the cluster cell as the target.
   Refer your WebSphere documentation for more details about its configuration scoping rules.

4. Enter the following configuration values for the new provider:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database type</td>
<td>User-Defined</td>
</tr>
<tr>
<td>Implementation class name</td>
<td>Enter one of the following class names depending on which database provider you are using:</td>
</tr>
<tr>
<td></td>
<td>• Oracle: albpm.jdbcx.oracle.OracleDataSource</td>
</tr>
<tr>
<td></td>
<td>• SQL Server: albpm.jdbcx.sqlserver.SQLServerDataSource</td>
</tr>
<tr>
<td></td>
<td>• DB2: albpm.jdbcx.db2.DB2DataSource</td>
</tr>
<tr>
<td>Name</td>
<td>BEA JDBC Provider</td>
</tr>
</tbody>
</table>

   ▶ Note: Ensure that you select User-defined for each of the supported database types. You must select this option in order to configure the JDBC drivers supplied by Oracle BPM.

5. Press Next to enter the JDBC Classpath information.
   You must list the following .jar files:
   <ORABPM_HOME>/libraries/b1oracle.jar (Oracle only)
   <ORABPM_HOME>/libraries/b1db2.jar (DB2 only)
   <ORABPM_HOME>/libraries/b1sqlserver.jar (SQL Server only)
   <ORABPM_HOME>/libraries/b1util.jar
These files are installed with Oracle BPM Enterprise. You must specify the full path to each of these jar files. Each must be defined on its own line.

To avoid hard-coding the full paths, you can copy the .jar files to a common directory, then define a new WebSphere environment variable (e.g. ORACLE_JDBC_DRIVERS_PATH) containing the path to this directory. You can then, specify the classpath as follows:

```text
${ORACLE_JDBC_DRIVERS_PATH}/b1oracle.jar
${ORACLE_JDBC_DRIVERS_PATH}/b1util.jar
${ORACLE_JDBC_DRIVERS_PATH}/b1resource.jar
${ORACLE_JDBC_DRIVERS_PATH}/b1base.jar
${ORACLE_JDBC_DRIVERS_PATH}/fuego.database.websphere.helper.jar
```

6. Click **Next** again, and **Finish** after reviewing all selected options.
7. Click on **Save** to persist your WebSphere configuration changes.

The new JDBC provider using BEA's drivers is now configured.

### Creating a JDBC Datasource for Directory Database

After creating a JDBC Provider, you must create a JDBC datasource to provide database connectivity to Oracle BPM applications. The following procedures show you how to create a JDBC datasource for the Oracle BPM directory database.

Before creating the JDBC Datasources you must have defined:

- A new JDBC provider containing the drivers provided by Oracle, as explained in Creating a New JDBC Provider on page 23.
- Two authentication data entries: one for the Oracle BPM Directory Database and one for Oracle BPM Engine's back-end database, as explained in Adding Authentication Data for JDBC on page 22.

To create a JDBC datasource for the directory DB:

1. Login to WebSphere's Administration Console. By default, it runs on http://host:9060/ibm/console.
2. Go to **Resources ➤ JDBC ➤ JDBC Providers** and click on the Oracle JDBC Provider you created previously.
3. Click on **Data sources**, located in the **Additional properties** section.
4. Click **New** to create a new Data source for Oracle BPM Directory database.
5. Enter the following configuration information for your new data source:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Oracle BPM Directory Data Source</td>
</tr>
<tr>
<td>JNDI Name</td>
<td>FDIDS</td>
</tr>
<tr>
<td>Component-managed Authentication Alias</td>
<td>Select the Authentication entry you defined previously for Oracle BPM Directory database. For example: node/Oracle BPM Directory DB Auth</td>
</tr>
</tbody>
</table>

6. Click **Next** and enter the following Data store helper class name: albpm.jdbc.websphere.ALBPMDataStoreHelper.
7. Click **Next**, then **Finish** after reviewing all selected options.
8. Select the data source you just created.
9. Click Custom properties located under the Additional properties section in the right pane.
   You should see a complete list of all driver properties. If you do not see this list, there is an error with
   your configuration.
10. Configure the connectivity properties for your database vendor.
    See Engine and Directory Database Connectivity on page 60 for more information. For general information
    on using the JDBC drivers provided with Oracle products, see JDBC Drivers.
11. Click Save to persist your WebSphere configuration changes.
12. Test your datasource configuration.
    a) Expand JDBC ➤ JDBC Providers
    b) Select the JDBC datasource you just configured
    c) Click Data sources
    d) Select the checkbox next to the datasource you want to test
    e) Click Test Connection

The JDBC datasources for the Oracle BPM Directory database is configured.

Creating a JDBC Datasource for the Engine Database

After creating a JDBC datasource for the directory database, you another JDBC resource to provide database
connectivity to Oracle BPM applications for the Oracle BPM engine database.

Before creating the JDBC Datasources you must have defined:

- A new JDBC provider containing the drivers provided by BEA, as explained in Creating a New JDBC
  Provider on page 23.
- Two authentication data entries: one for the Oracle BPM Directory Database and one for Oracle BPM
  Engine's backend database, as explained in Adding Authentication Data for JDBC on page 22.

To configure a JDBC datasource for the engine database:

1. Login to WebSphere's Administration Console. By default, it runs on http://host:9060/ibm/console.
2. Go to Resources ➤ JDBC ➤ JDBC Providers and click on the BEA JDBC Provider you created previously.
3. Click on Data sources, located in the Additional properties section.
4. Click New to create a new Data source for Oracle BPM Engine database.
   Enter the following configuration information for the new data source:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data source name</td>
<td>Oracle BPM Engine Datasource</td>
</tr>
<tr>
<td>JNDI name</td>
<td>XAEngineDS</td>
</tr>
<tr>
<td>Component-managed Authentication Alias</td>
<td>Select the Authentication entry you defined previously for Oracle BPM Engine database. Example: &lt;node&gt;/Oracle BPM Engine DB Auth</td>
</tr>
</tbody>
</table>

5. Click Next and enter the following Data store helper class name: albpm.jdbc.websphere.ALBPMDataStoreHelper.
6. Click Next again, and Finish after reviewing all selected options.
7. Select your newly created Data source.
8. Click Custom properties located under the Additional properties section.
9. Configure the connectivity properties for your database vendor.
See *Engine and Directory Database Connectivity* on page 60 for more information. For general information on using the JDBC drivers provided with BEA products, see *JDBC Drivers*.

10. Click on **Save** to persist your WebSphere configuration changes.

The JDBC Datasource for Oracle BPM Engine database is configured.

**Creating a WebSphere JMS Bus**

You need to provide a JMS service to Oracle BPM applications. This procedure shows you how to configure WebSphere Application Server's Embedded JMS service. Other external JMS providers may be used. Check the Installation Guide for compatibility information.

WebSphere Application server defines the concept of a *Bus* to manage JMS resources. Before creating Queues and Topics, you must create a Bus.

1. Login to WebSphere's Administration Console. By default, it runs on `http://host:9060/ibm/console`.

2. Create a new Bus
   a) Go to **Service Integration ➤ Buses** press **New** to add a new Bus.
   b) Enter a name for this Bus. Example: Oracle BPM Bus.
   c) Press **Next** again, and **Finish**.

3. Add members (servers/clusters) to your newly created Bus.
   Click on your Bus and then on **Bus members**, located in the **Topology** section.
   For each server you want to add as a member:
   a) Press **Add** and select the server/cluster to add as member.
   b) Press **Next** and select the type of message store you want. You may use the default.
   c) Press **Next** and review the message store properties. You may use the default values.
   d) Press **Next** again, and **Finish** after reviewing all selected options.

4. Create a Queue Destination in your Bus:
   a) Go back to **Service Integration ➤ Buses**, and click on your newly created Bus.
   b) Click on **Destinations** located in the **Destination Resources** section on the right.
   c) Press **New** and select Queue for the destination type.
   d) Enter `BPMEngineQueue` as the Identifier.
   e) Press **Next** and select the bus member which will serve this Queue destination.
   
   **Note:** If you are configuring a single-node environment, you must select the server as a member.
   If you are configuring a clustered environment, you must the target cluster name or identifier.

   f) Press **Next** again, and **Finish**.

5. Create a Topic Space in your Bus:
   a) Go back to **Service Integration ➤ Buses**, and click on your newly created Bus.
   b) Click on **Destinations** located in the **Destination Resources** section on the right.
   c) Press **New** and select Topic space for the destination type.
   d) Enter `BPMTopic` as the Identifier.
   e) Press **Next** and select the bus member which will serve this Topic destination.
   
   **Note:** If you are configuring a single-node environment, you must select the server as a member.
   If you are configuring a clustered environment, you must the target cluster.

   e) Press **Next** and **Finish**.

6. Click on **Save** to persist your WebSphere configuration changes.
Creating JMS Resources

You need to define a JMS Queue Connection Factory, a Queue, a Topic Connection Factory and a Topic for Oracle BPM applications.

1. Login to WebSphere’s Administration Console. By default, it runs on http://host:9060/ibm/console.
2. Create a Queue Connection Factory:
   a) Go to Resources ➤ JMS ➤ Queue connection factories.
      
      Note: You must select a WebSphere configuration scope for your new resources.

      If you are configuring a single-node environment, you must select the server as a member. If you are configuring a clustered environment, you must select the target cluster.

      Refer to your WebSphere documentation for more details about its configuration scoping rules.

   b) Press New. Select Default messaging provider and press OK.
   c) Review the configuration properties for this Connection Factory.

      Make sure you set the following properties:

      | Option            | Value                                      |
      |-------------------|--------------------------------------------|
      | Name              | Oracle BPM QCF                             |
      | JNDI Name         | XAConnectionFactory                         |
      | Bus name          | Select the name of the JMS Bus you created (see Creating a WebSphere JMS Bus on page 26). Example: Oracle BPM Bus |

   d) Press OK when finished setting the configuration properties.

3. Create a Topic Connection Factory
   a) Go to Resources ➤ JMS ➤ Topic connection factories.

      Note: You must select a WebSphere configuration scope for your new resources.

      If you are configuring a single-node environment, you must select the server as a member. If you are configuring a clustered environment, you must select the target cluster.

      Refer to your WebSphere documentation for more details about its configuration scoping rules.

   b) Press New. Select Default messaging provider and press OK.
   c) Review the configuration properties for this Connection Factory.

      Make sure you set the following properties:

      | Option            | Value                                      |
      |-------------------|--------------------------------------------|
      | Name              | Oracle BPM TCF                             |
      | JNDI Name         | XATopicConnectionFactory                    |
      | Bus name          | Select the name of the JMS Bus you created (see Creating a WebSphere JMS Bus on page 26). Example: Oracle BPM Bus |

   d) Press OK when finished setting the configuration properties.

4. Create a Queue
a) Go to Resources ➤ JMS ➤ Queues.

Note: You must select a WebSphere configuration scope for your new resources.

If you are configuring a single-node environment, you must select the server as a member. If you are configuring a clustered environment, you must select the target cluster.

Refer to your WebSphere documentation for more details about its configuration scoping rules.

b) Press New. Select Default messaging provider and press OK.

c) Review the configuration properties for this Queue.

Make sure you set the following properties:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Oracle BPM Engine Queue</td>
</tr>
<tr>
<td>JNDI Name</td>
<td>queue/ToDoQueue</td>
</tr>
<tr>
<td>Bus name</td>
<td>Select the name of the JMS Bus you created (see Creating a WebSphere JMS Bus on page 26). Example: Oracle BPM Bus</td>
</tr>
<tr>
<td>Queue name</td>
<td>Select the name of your Queue Destination (see Creating a WebSphere JMS Bus on page 26). Example: OracleBPMEngineQueue</td>
</tr>
<tr>
<td>Delivery Mode</td>
<td>Nonpersistent</td>
</tr>
</tbody>
</table>

d) Press OK when finished setting the configuration properties.

5. Create a Topic

a) Go to Resources ➤ JMS ➤ Topics.

Note: You must select a WebSphere configuration scope for your new resources.

If you are configuring a single-node environment, you must select the server as a member. If you are configuring a clustered environment, you must select the target cluster.

Refer to your WebSphere documentation for more details about its configuration scoping rules.

b) Press New. Select Default messaging provider and press OK.

c) Review the configuration properties for this Topic.

Make sure you set the following properties:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Oracle BPM Topic</td>
</tr>
<tr>
<td>JNDI Name</td>
<td>topic/EngineNews</td>
</tr>
<tr>
<td>Bus name</td>
<td>Select the name of the JMS Bus you created (see Creating a WebSphere JMS Bus on page 26). Example: Oracle BPM Bus</td>
</tr>
<tr>
<td>Topic space</td>
<td>Select the name of your Topic space (see Creating a WebSphere JMS Bus on page 26). Example: OracleBPMTopic</td>
</tr>
</tbody>
</table>
d) Press OK when finished setting the configuration properties.

6. Create a JMS Activation specification
   a) Go to Resources ➤ JMS ➤ Activation specification .

   Note: You must select a WebSphere configuration scope for your new resources.
   If you are configuring a single-node environment, you must select the server as a member. If you are configuring a clustered environment, you must the target cluster.
   Refer to your WebSphere documentation for more details about its configuration scoping rules.
   
   b) Press New. Select Default messaging provider and press OK.
   
   c) Review the configuration properties for this Activation Spec.
   Make sure you set the following properties:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Oracle BPM Activation</td>
</tr>
<tr>
<td>JNDI Name</td>
<td>EngineActiveSpec</td>
</tr>
<tr>
<td>Destination type</td>
<td>Queue</td>
</tr>
<tr>
<td>Destination JNDI name</td>
<td>queue/ToDoQueue</td>
</tr>
<tr>
<td>Bus name</td>
<td>Select the name of the JMS Bus you created (see Creating a WebSphere JMS Bus on page 26). Example: Oracle BPM Bus</td>
</tr>
</tbody>
</table>

   d) Press OK when finished setting the configuration properties.

7. Click on Save to persist your WebSphere configuration changes.

Configuring a Work Manager
You need to create a Work Manager configuration in WebSphere to provide asynchronous transaction processing capabilities to Oracle BPM Engine.

1. Login to WebSphere’s Administration Console. By default, it runs on http://host:9060/ibm/console.
2. Go to Resources ➤ Asynchronous beans ➤ Work managers and press New to create a new Work Manager.

   Note: You must select a WebSphere configuration scope for your new resources.
   If you are configuring a single-node environment, you must select the server as a member. If you are configuring a clustered environment, you must the target cluster.
   Refer to your WebSphere documentation for more details about its configuration scoping rules.

3. Enter the following configuration values for the new Work manager:

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Oracle BPM WorkManager</td>
</tr>
<tr>
<td>JNDI name</td>
<td>wm/albpmWorkManager</td>
</tr>
</tbody>
</table>

4. Press OK after reviewing all selected options.
5. Click on Save to persist your WebSphere configuration changes.
The new Work manager for Oracle BPM Engine is now configured.

**Configuring JVM Properties**

You must configure each WebSphere Server to use additional system properties when launching the Java Virtual Machine.

Note: In a clustered configuration, you must execute the following procedures for each cluster node.

1. Login to WebSphere's Administration Console. By default, it runs on http://host:9060/ibm/console.
2. Go to **Servers ➤ Application servers**. You will see a list of all available servers.
3. Follow this procedure for each Server in which you will install Oracle BPM applications:
   a) Expand **Java and Process Management** and click on **Process Definition**
   b) Click on **Java Virtual Machine** then on **Custom Properties**.
   c) Add the following properties:

<table>
<thead>
<tr>
<th>New Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>java.awt.headless</td>
<td>true</td>
</tr>
</tbody>
</table>

**Restarting WebSphere Servers**

After configuring all the needed resources in your WebSphere installation, you must re-start all your WebSphere Servers, Node managers and Deployment manager.

After re-starting WebSphere, you may want to check your Database connections:

1. Login to WebSphere's Administration Console. By default, it runs on http://host:9060/ibm/console.
2. Go to **Resources ➤ JDBC ➤ Data sources**.
4. Click **Test Connection** button.

You might want to check WebSphere’s log files in case of errors.

**Setting Oracle BPM properties for WebSphere**

You must configure your Process Engine with some WebSphere-related properties via Oracle BPM Process Administrator.

You must have an Oracle BPM Engine for WebSphere configured in order to define this configuration properties.

2. Click on **Engines** and then click on the name of your Oracle BPM Engine for WebSphere.
   You should see the configuration properties for your Engine.
3. Click on the **Application Server** tab.
4. In the **JMX Engine Management Configuration** section you must specify the **Host** and **Port** of one of the WebSphere servers that will be running Oracle BPM Engine.

   The port number is that of the WebSphere server's SOAP Connector address. You can obtain this value from the WebSphere Administration console: go to **Servers ➤ Application servers ➤ YOUR_SERVER (e.g. server1) ➤ Ports**, and look for the value of the SOAP_CONNECTOR_ADDRESS property.

   For example, on a default single-node WebSphere configuration where Oracle BPM Process Admin is running on the same host as WebSphere you would use:
5. Locate the **BPM Application Deployer URL** field, and change its value to match your WebSphere configuration.

   **Note:** The BPM Application Deployer is only supported on single-node WebSphere configurations.

   For example, on a default single-node WebSphere configuration, it would be:

   `http://localhost:9080/fuego/deployer/servlet/worker`

   The URL should be that of the WebSphere server where Oracle BPM Deployer is installed, which must be your WebSphere's Deployment Manager server (dmgr).

   Refer to *Installing Oracle BPM Deployer* on page 21 for more details.

6. Change the **WebSphere Server/Cluster Name** field to match your WebSphere configuration. This is the name of the WebSphere Server or Cluster where you want to install the Oracle BPM applications.

   For example, on a default single-node WebSphere configuration, it would be: `server1`.

---

**Preparing Oracle BPM Applications**

Some of the Oracle BPM applications need additional configuration changes before deploying them into WebSphere.

1. Copy file `<ORABPM_HOME>/j2ee/websphere/was6stubs/fuegoj2ee-was6-stubs.jar` into each of following directories:

   `<ORABPM_HOME>/webapps/archivingviewer/WEB-INF/lib`
   `<ORABPM_HOME>/webapps/feeds/WEB-INF/lib`
   `<ORABPM_HOME>/webapps/papiws/WEB-INF/lib`
   `<ORABPM_HOME>/webapps/portal/WEB-INF/lib`
   `<ORABPM_HOME>/webapps/portaladmin/WEB-INF/lib`
   `<ORABPM_HOME>/webapps/webconsole/WEB-INF/lib`
   `<ORABPM_HOME>/webapps/workspace/WEB-INF/lib`

   This is to allow client applications to connect with the EJB-based Process Engine running on WebSphere.

2. Create a new directory named `jmxextensions` under `<ORABPM_HOME>/webapps/webconsole/WEB-INF/`.

3. Copy file `WEBSPHERE_HOME/AppServer/runtimes/com.ibm.ws.admin.client_6.1.0.jar` to the `jmxextensions` directory you just created on the previous step:

   `<ORABPM_HOME>/webapps/webconsole/WEB-INF/jmxextensions/`

   This is to allow the Process Administrator application to connect with the Process Engines via JMX.

---

**Enabling Clustering**

If you are configuring your Oracle BPM Enterprise to run within a clustered J2EE environment, you must enable clustering using the Process Administrator.

1. Launch the Process Administrator
2. Select `Engines`
3. Select the engine where you want to enable clustering.
4. Select Basic Configuration
5. Enable the Cluster checkbox.

After enabling clustering, the Cluster tab appears in the Edit Engine page.

Building and Deploying Application EAR Files

The Oracle BPM Process Administrator allows you to create the Oracle BPM application .ear files and deploy them on your application server.

To use Process Administrator to create and deploy Oracle BPM application EAR files, you must deploy and start the Oracle BPM Deployer application. Before creating the Oracle BPM application archives, you must configure a process execution engine.

Note: When configuring WebSphere Application Server, you can only use Process Administrator to deploy applications in a single-node configuration. The BPM Deployer application is not supported in multi-node configurations.

1. Login to Oracle BPM Process Administrator.
2. Click on Engines
3. Select the engine where you want to create the application
   You should see the configuration properties for your Engine.
4. Click Basic Configuration.
5. Click J2EE Application Server Files.
   This page allows you to generate the EAR files for the Oracle BPM applications associated with this Engine.
   Note: When you access this page, the Process Administrator gets the status of each of the applications by contacting Oracle BPM Deployer. You will get a warning message at the bottom of the page if there was any problem contacting Oracle BPM Deployer. If this is the case, make sure the BPM Application Deployer URL (within the Application Server tab) is correct and that Oracle BPM Deployer is running.

6. Click Create EAR ( ) next to each of the applications you want to install.
7. Click Install ( ) next to each of the applications you want to install.
   Attention: This may take several minutes. Do not click any link on the page and do back in your browser until the page is automatically reloaded.

Deploying and Publishing a New BPM Project

This task outlines the procedures for deploying and publishing a new project using the Process Administrator. See Creating a Project Version if you are publishing and deploying a new version of an existing project.

1. Launch the Process Administrator
2. Click Projects
3. Click Publish
   The Publication Source pane appears
4. Select the Publication Source
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project at Web Server Host</td>
<td>Allows you to select a BPM Project from the file system of the server where the Process Administrator is running.</td>
</tr>
<tr>
<td>Exported Project</td>
<td>Allows you to select an exported BPM Project from the file system of the local computer where your web browser is running.</td>
</tr>
</tbody>
</table>

5. Select **Deploy processes after publishing them**.
6. Click **OK**.
   
   The **Publish Process** pane appears.
7. Expand **Role Mapping**.
8. Map the Roles
9. Click **Publish**.
   
   The **Deployment Topology** pane appears.
10. Click **OK**.

   To perform a basic deployment of a project, use the default values for these fields.

   Your project appears in the list of deployed projects.

### Configuring SSL for Oracle BPM Web Applications

You can configure the Oracle BPM web applications to use the Secure Socket Layer (SSL) to encrypt data transfers between applications. However, SSL is configured at the application server level. See the documentation for your application server for more information.

💡 **Note:** When using the Oracle BPM Configuration Wizard to create an Oracle WebLogic Server domain and deploy the Oracle BPM applications, SSL is disabled by default. You must manually enable SSL.
Integrating Oracle BPM with Other Oracle Products

This section contains tasks for integrating Oracle BPM with other Oracle products.

⚠️ **Note:** Before performing the tasks in this section, review *Configuration Overview* on page 8

---

### Integrating AquaLogic Service Bus

Service Bus functions as a repository for business services exposed as web services. Oracle BPM processes exposed as web services can be consumed by ALSB. Also, web services provided by ALSB can be cataloged as part of an Oracle BPM project.

See [http://e-docs.bea.com/alsb/docs30/index.html](http://e-docs.bea.com/alsb/docs30/index.html) for more information on using Service Bus.

### Registering a BPM Process on AquaLogic Service Bus

The following high-level task outlines the procedures for registering Oracle BPM processes with AquaLogic Service Bus.

1. Create a Management Host Configuration external resource.
   
   See [Creating a Management Host Configuration](#) on page 34

2. Create a Process Registration external resource.
   
   See [Creating a Process Registration Configuration](#) on page 35

   
   See [Registering a BPM Process with ALSB](#) on page 35

---

### Creating a Management Host Configuration

A Management Host configuration allows you to define the connectivity information for your ALSB installation.

1. Launch Process Administrator
2. Click **External Resources**.
3. Click **Add**.
4. Provide a name for your external resource.
5. Select **AquaLogic Service Bus** under **Type**.
6. Select **Management Host** under **Subtype**.
7. Click **Next**.
8. Provide the following connectivity information for your ALSB installation:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies the hostname for your ALSB installation. This can be the DNS hostname or IP address.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port for your ALSB installation.</td>
</tr>
<tr>
<td>User</td>
<td>Specifies the user name for your ALBSB administrator.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies the password for your ALSB administrator.</td>
</tr>
</tbody>
</table>

9. Click **Save** to create the new external resource.
The new external resource is created based on the connectivity information you provided.

Note: Process Administrator does not verify the connection to the ALSB installation. If you have trouble connecting to your ALSB installation verify the connectivity information.

Creating a Process Registration Configuration
A Process Registration external resource allows you to define the server, project, and folders where the Oracle BPM process is registered.

1. Launch Process Administrator
2. Click External Resources.
3. Click Add.
4. Provide a name for your external resource.
5. Select AquaLogic Service Bus under Type.
6. Select Process Registration under Subtype.
7. Click Next.
8. Select a Management Host external resource.
   The Management Host configuration specifies the connectivity information to the ALSB installation.
9. Enter the following information:
   
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Specifies the project where ALSB stores the Oracle BPM processes.</td>
</tr>
<tr>
<td>WSDL Folder</td>
<td>Specifies WSDL folder for the ALSB project.</td>
</tr>
<tr>
<td>Business Services Folder</td>
<td>Specifies the Business Services Folder for the ALSB project.</td>
</tr>
</tbody>
</table>
   
10. Click Create Structure.
    Process Administrator connects to AquaLogic Service Bus to create the WSDL definitions. If the WSDL definitions are created, Process Administrator displays the message Structure created successfully.
11. Click Save.

Registering a BPM Process with ALSB
Before performing the following task, ensure that you have exposed the processes you want to register as Web Services. You must do this before publishing and deploying your Oracle BPM project. See the Oracle BPM Studio User Guide for more information.

You should also ensure that you have created external resources for the Oracle Service Bus Management Host Configuration and Process Registration Configuration.

1. Launch the Process Administrator
2. Click Projects.
3. Select the project containing the processes you want to register with Oracle Service Bus.
4. Click Oracle Service Bus Registration.
   The Oracle Service Bus Registration window appears.
5. Select the registration configuration created in a previous step.
6. Select a process from the list of processes.
7. Click Register.
   If the process is registered successfully, the status under the Registered column is Yes
Supported Transport Protocols
You can configure Oracle BPM and AquaLogic Service Bus proxy services and business services to use different transport protocols. The transport protocol you select depends on the service type, the type of authentication required, the service type of the invoking service, and so on.

Oracle BPM supports the following transport protocols:

- HTTP
- HTTPS
- Oracle BPM Custom Transport Protocol

For information on using the HTTP and HTTP transport protocols, see Transports in the AquaLogic Service Bus User Guide.

Oracle BPM Custom Transport
In addition to HTTP and HTTPS, Oracle BPM provides a custom transport protocol. To use the Oracle BPM custom transport protocol, you must deploy the Oracle BPM transport provider.

You must deploy the Oracle BPM transport provider like other AquaLogic Service Bus transport providers. See Deploying the Transport Provider in the Transport SDK User Guide for information.

Important: When you deploy the transport .ear on WebLogic you must select a deployment order of 50. Higher values may prevent the BPM custom transport from initializing properly.

The Oracle BPM transport provider .ear file is installed with Oracle BPM. The default location is:

<ORABPM_HOME>/j2ee/weblogic/alsb/alsb.transport.ear.

If your AquaLogic Service Bus installation resides on a separate machine that your Oracle BPM installation, you must copy this file to the ALSB location.

Integrating Oracle BPM with WebLogic Portal
The tasks in this section show you how to configure Oracle BPM WorkSpace to be used as a portal within WebLogic Portal.

1. Review Configuration Prerequisites
   See Installation Prerequisites on page 7. This topic provides information about the required software you must install before using this guide.

2. Configure Oracle BPM on Oracle WebLogic Server.
   Follow the procedures for WebLogic Server outlined in Configuring Oracle BPM Enterprise on J2EE on page 13. Depending on the requirements of your environment, you can create a single-node or clustered installation.

   Note: When configuring Oracle BPM, note the following:
   - Do not deploy the WorkSpace application. The WorkSpace application will be deployed on the WebLogic Portal in later steps.
   - Ensure that you configure Single Sign On (SSO)

3. Configure domain trust and create a foreign JNDI provider.
   If you are configuring an environment where WebLogic Portal and Oracle BPM are installed in different domains, you must perform this step. This allows the WorkSpace application domain to communicate with the domain where the Oracle BPM engine is deployed.

   See Configuring WorkSpace Across Multiple Domains on page 58 for more information.
4. Create the WorkSpace application files
   See *Generate the WorkSpace Application* on page 37.

5. Create the weblogic participant
   You must create a weblogic participant within your Oracle BPM organization. This participant must have
   the same username and password you use for your Oracle WebLogic Server domain. You must also ensure
   that this participant is assigned to the proper roles for the projects you are deploying.
   See *Creating a Participant Using Process Administrator* on page 37 for information on creating a participant.

6. Deploy the Oracle BPM WAR file to WebLogic Portal.
   See *Deploying the WAR File in WebLogic Portal* on page 38.

7. Create Oracle BPM portlets.
   See *Creating a New Portal* on page 40.

8. Create the Login portlet.
   See *Importing the Login Portlet* on page 40.

9. Verify your installation.
   See *Verifying your Installation* on page 41.

---

**Generate the WorkSpace Application**

Oracle BPM WorkSpace is designed to perform authentication by itself. To use WorkSpace within a WebLogic
Portal container, Oracle BPM authentication must be container-based. This requires you to configure the
Oracle BPM Directory Service to work in trusted mode. WorkSpace must also be configured to support this
configuration from a client perspective.

The following procedures show you how to create and configure the Oracle BPM WorkSpace WAR file.

1. Launch the Oracle BPM Admin Center
2. Select *Start BPM Applications*.
   This starts the Oracle BPM Applications that run on the Tomcat Application Server.
3. Click *Launch Process Administrator*.
4. Enter the administrator username and password.
5. Click *Engines* in the left hand pane.
6. Click the engine whose WAR file you want to generate.
7. Click *J2EE Application Server File*.
8. Click the icon next to *Oracle AquaLogic BPM WorkSpace WAR*.
   The Oracle BPM WorkSpace WAR file is generated and a link to the WAR file appears.
9. Right-click 08-workspace-wp-FDIDS.war, then select *Save Link As*.
10. Select a location to save the WAR file.
11. Click *Logout*.

The WorkSpace WAR file is saved on your local file system. You will need to access this file in later tasks.

---

**Creating a Participant Using Process Administrator**

1. Launch Process Administrator
2. Select *Organization ➤ Participants*.
3. Click *Add*
4. Enter information for the new participant
5. Click **Save**.
   The **Advanced Properties** section appears.

6. Assign any groups or roles to this participant.
   You can assign groups and roles later, if necessary.

7. Click **Save** to create the new participant.
   The new participant appears in the list of participants within your organization.

---

**Deploying the WAR File in WebLogic Portal**

The following procedures show you how to deploy the modified WAR file in WebLogic Portal using WorkShop for WebLogic Platform.

2. Select a workspace, then click **OK**.
3. Click Workbench
4. Create a new Portal EAR project.
   a) Select **File ➤ New ➤ Other**
   b) Expand WebLogic Portal
   c) Select Portal Ear Project, then click **Next**.
   d) Enter a project name, then click **Next**.
      The **Project Facets** window appears.
   e) Ensure that the following are selected:
      - EAR
      - WebLogic EAR Extensions
      - WebLogic Portal
   f) Click **Finish**.
   g) Click **Yes** if you are prompted to open the Portal perspective.
   Your new Portal EAR project appears in the Project view.

5. Create a Portal Web Project
   You must add this portal web project to the Portal EAR project created in the previous step. You must also select JSF from Project Facelets when creating the Web Project.
   a) Select **File ➤ New ➤ Portal Web Project**
   b) Enter the Project Name
   c) Check the **Add project to an EAR** checkbox.
   d) Select the EAR file edited in previous tasks.
   e) Click **Next**.
   f) Ensure that the JSF option is selected.
      - **Note:** You must ensure that the JSF version is 1.1.
   g) Click **Next**.
      The **Web Module** window appears.
   h) Continue clicking **Next** until the JSF page appears.
   i) On the JSF page, select **Use Sun RI WebLogic J2EE Library**.
      - **Note:** You must ensure that the JSF version is 1.1.
   j) Click **Finish**.
   Your Portal Web project appears in the Project navigator.
6. Add Oracle BPM Libraries to the Build Path
   a) Right-click WorkSpace ➤ Build Path ➤ Configure Build Path
      The Properties for Work Shop dialog appears.
   b) Select Java Build Path
   c) Click the Libraries tab.
   d) Click Add Library.
      The Add Library dialogue appears.
   e) Select WebLogic Shared Library.
   f) Click Next.
   g) Click Browse.
      The list of shared libraries appears.
   h) Click Manage WebLogic Shared Libraries.
      The Shared Library dialog appears.
   i) Click Add.
      The Add WebLogic Shared Libraries dialogue appears.
   j) Click Browse.
   k) Select the Oracle BPM WorkSpace WAR file.
   l) Click Open.
   m) Click OK.
   n) Click OK.
   o) Select Shared Libraries.
   p) Click OK.
   q) Click Finish.
   r) Click OK.
      The WorkSpace libraries are added to the build path of your Portal web project.

7. Add Oracle BPM Libraries to the Runtime Environment
   a) Expand the Portal web project
   b) Expand Web Content ➤ WEB-INF.
   c) Double-click weblogic.xml
      The weblogic.xml appears in the Editor View.
   d) Select the Libraries tab.
      The Select WebLogic Shared Library dialog appears.
   e) Click Add.
   f) Select the WorkSpace library.
   g) Click OK.
   h) Save your revisions.

8. Copy Resources to the Local Project
   a) Expand the Portal Web Project
   b) Expand Merged Project Content ➤ WEB-INF.
   c) Right-click directory.xml, then select Copy to Project.
   d) Right-click workspace.properties, then select Copy to Project.
   e) Expand WebContent ➤ WEB-INF.
   f) Double-click web.xml
      The deployment descriptor elements appear in the Editor view.
   g) In the Editor view, expand ContextParams.
   h) Select javax.faces.STATE_SAVING_METHOD
   i) Change the Param Value to server.
   j) Right-click ContextParams, then select New ContextParam.
   k) Enter the following values:
l) Click OK.

   This must point to the same WebLogic Portal domain created earlier.
   a) Open the Server View.
   b) Right click in the view, then select New ➤ Server
   c) Select WebLogic Server 10.
   d) Click Next.
   e) Click Browse, then select the WebLogic Portal domain.
      This must be the WebLogic domain created earlier. If you are using a two domain configuration, then
      this must be the WebLogic Portal domain created earlier.
   f) Click OK.
   g) Click Next.
   h) Select the EAR file edited previously.
   i) Click Add.

      This adds the EAR to the list of configured projects.
   j) Click Next.
   k) Click Finish.

Importing the Login Portlet

1. Locate the Login Portlet
   The login portlet is shipped with Oracle BPM. It is located in the
   ORABPM_HOME/samples/interop/WebLogicPortal_LoginPortlet.zip directory.
2. Right-click WorkSpace ➤ Import ➤ Import
   The Import dialogue appears.
3. Expand General.
4. Select Archive File
5. Click Next.
6. Click Browse
7. Select the zip file for the login portlet.
8. Click Open.
9. Ensure that all elements of the zip file are selected.
10. Click Finish.

Creating a New Portal

1. In the Project Navigator view, expand your Web Portal Project folder
2. Right-click the WebContent folder
3. Select New ➤ Portal
4. Provide a name for your portal.
5. Click Finish
   The following procedures show how to create a basic portal layout, however you can customize your portal as necessary.
   ✔ Note: You should not use flow layouts within your portal. Flow layouts are not supported by Oracle BPM.

6. In the Preferences View, change the following:
   • Select Single Column Layout
   • Change the title

7. Select the Login Portlet from the design palette view, and drag it on the Portlet editor view
8. In the portlet Editor, right-click Insert ➤ New Page
9. Set the layout to 2 column
10. Add the following portlets by dragging and dropping them from the Design Palette View:
   • Menu Action
   • Work List
   • Instance Detail

11. Save you portal
12. In the Server View, Right-click your WebLogic Server installation
13. Select Publish

After performing the steps above, you should be able to start the WebLogic Portal using the portal and portlets.

Verifying your Installation
This section shows you how to test your configuration of the Oracle BPM WorkSpace using the WebLogic Portal.

1. Start the WebLogic Server instance configured to run Oracle BPM and WebLogic Portal.
2. Ensure that your WebLogic Portal and Oracle BPM user bases are synchronized.
3. Deploy a sample BPM Project using the Process Administrator.
   Oracle BPM example projects are located in the Samples directory of you Oracle BPM installation. See Deploying and Publishing a New BPM Project on page 32 for more information.
4. Open the WebLogic Portal URL
   To access the WorkSpace within WebLogic portal, use the following URL: http://host:port/your_portal_project/portal_file
   For example: http://localhost:7001/wlpPortalProject/albpm.portal
5. Login to the WebLogic Portal using weblogic as the username and password.
   ✔ Note: You must ensure that this user has been created using the Oracle BPM Process Administrator and has been granted the proper roles.

   The Oracle BPM portlets appear containing the activities of the sample project you deployed.
Integrating Oracle BPM with AquaLogic Interaction

Oracle BPM provides out-of-the-box integration using WorkSpace Extensions for AquaLogic User Interaction.

Note: The following procedures assume that you have installed and performed basic configuration of your AquaLogic Interaction environment.

WorkSpace Extensions for ALI allow you to use Oracle BPM with the following functionality:

- Use ALI as the user interface layer for Oracle BPM
- Use ALI to handle user authentication
- Use ALI Collaboration as the document repository for attachments.

1. Review Installation Prerequisites on page 7
   This topic provides information about the required software you must install before using this guide.

2. Run the WorkSpace Extension configuration wizard.
   See Running the WorkSpace Extension Configuration Wizard on page 42.

3. Deploy the .pte File
   See Deploying the .pte File on page 43

4. Assign an ALI administrator to the process administrator group.
   See Assigning Process Administrators on page 43

5. Configure Oracle BPM
   See Configure Oracle BPM Enterprise on page 43 for more information.

6. Restart the ALI services
   See Restart ALI Services You must re-start ALI services to force a quick replication of users and groups information from the ALI Portal database to ALI’s Identity Service (Hydrogen).

7. Verify your installation
   See Verifying Your Installation on page 44

Running the WorkSpace Extension Configuration Wizard

The following procedures show you how to run the WorkSpace Extension Configuration Wizard.

The WorkSpace Extension Configuration Wizard is located at: \<ORABPM_HOME\>/bin/weconfigwizard.exe.

Run the Configuration Wizard as outlined in the following table:

<table>
<thead>
<tr>
<th>Configuration Wizard Page</th>
<th>User Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Image Server URL</td>
<td>Provide the connectivity information to the ALI Image Server.</td>
</tr>
<tr>
<td></td>
<td>Note: If you are not using the ALI Image Server to maintain the Oracle BPM WorkSpace images, you should leave this field blank.</td>
</tr>
<tr>
<td>Configuration Finished</td>
<td>Click Finish to close the WorkSpace Extensions configuration wizard.</td>
</tr>
</tbody>
</table>

The WorkSpace Extensions configuration wizard creates a file called imageServerResources.zip in the \<ORABPM_HOME\>/serverpackages directory.
Deploying the .pte File
You must import the ALI (.pte) file in order to expose the WorkSpace and Process Administrator applications within the ALI Portal and access the Portal Community that hosts it. This file defines all the associations between ALI and the Oracle BPM environment.

The .pte file is provided with the Oracle BPM Enterprise and is located in <ORABPM_HOME>/serverpackages/weinstall.pte.

See the AquaLogic Interaction Administrator Guide for more information on how to deploy the .pte file.

Assigning Process Administrators
You must add at least one ALI user to the Process Administrator group.

1. Login to ALI's portal as an Administrator. By default, it runs on http://host:8080/portal/server.pt.
2. Click on the Administration tab. You should see a new Process folder.
4. You may add new members to the group by pressing the Add User/Group button.

Configure Oracle BPM Enterprise
When integrating AquaLogic Interaction with Oracle BPM, you must configure the directory service database to use Generic JNDI as the organization provider.

You must also specify the generic_aluidirectory.conf configuration file. This allows the Oracle BPM directory service to communicate directly with AquaLogic Interaction LDAP server.

See Configuring Oracle BPM Enterprise on J2EE on page 13 for information on configuring Oracle BPM. See Oracle BPM Configuration Wizard Reference on page 66 for more information.

The specific information you need to provide when using the Oracle BPM Configuration Wizard is described in the sections below.

Directory Provider Selection
On the Directory Provider Selection screen, you must select Generic JNDI as the provider type.

You must also enter the username and password for the Oracle AquaLogic Interaction administrator.

Note: The admin ID must contain a password. Although by default, the Oracle AquaLogic Interaction admin id does not contain a password, Oracle BPM requires that it has one.

Configure Organization Provider
On the Configure Organization Provider screen, you must enter the connectivity information to point to your installation. The following table describes the required settings for each parameter:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context Factory</td>
<td>Defines the context factory used to create the LDAP connection. The default is:com.sun.jndi.ldap.LdapCtxFactory. You must use the default context factory when integrating Oracle User Interaction.</td>
</tr>
</tbody>
</table>
### Parameter | Description
--- | ---
**URL**<br>Specifies the URL to connect to ALI’s LDAP provider. This URL is of the form:<br>`ldap://host_name:port/dc=oracle,dc=com`<br>• `ldap://` - specifies the LDAP protocol.<br>• `host_name` - specifies the host name where the ALI LDAP provider is running.<br>• `port` - specifies the port where the Oracle Interaction LDAP provider is running.<br>• `dc=` - specifies the domain component. You must explicitly provide the domain component for your ALI installation. For example, if your installation is running on a domain at oracle.com, you would specify `dc=oracle,dc=com`.<n**Principal**<br>Specifies the principal or ID used to connect to the ALI LDAP provider. For example, `uuid=ali_admin_user,ou=osers,dc=oracle,dc=com`<n**Credentials**<br>Specifies the password for the ALI administrator user.<n**LDAP Configuration Properties**<br>Allows you to choose a configuration mapping file. This file is used to map the Oracle BPM LDAP structure to the ALI LDAP structure.<br>**Note:** You must choose the ALI mapping file provided by Oracle. This file is located in: `ORBPM_HOME/conf/generic_aluidirectory.conf`

### Verifying Your Installation
Following this procedure to verify the configuration of Oracle BPM WorkSpace Extensions for ALUI.

1. **Start Oracle BPM Web Applications.**
   
   See [Starting BPM Web Applications](#) for more information.

2. **Verify that the Oracle BPM Process Administrator is correctly configured.**
   
   a) Login to ALI's Portal as a user in the Process Administrator group. By default, it runs on [http://host:8080/portal/server.pt](http://host:8080/portal/server.pt).
   
   b) Click on the Administration tab.
   
   c) Select Process Administrator from the Select Utility... drop down.
   
   The Oracle BPM Process Administrator welcome page should appear.
   
   d) You can go to Organization ➤ Participants and Organization ➤ Groups to verify that the ALI users appear as Oracle BPM Participants.

3. **Verify that your Process Execution Engine is up and running.**
   
   a) In the Process Administrator click on Engines. Verify that the Status of your Engine (by default named `albpmengine`) is Running.
   
   If the Engine status is Not Running, try to start it by clicking on the Start icon (.Imaging).

   **Note:** If the Engine fails to start, click on the Start-up log icon (.Imaging) to look for errors.

   **Note:** By default, the Process Execution Engine uses TCP port 10099 to accept client connections. If Oracle BPM is running on the same box as the ALI components, you might need to change this...
default TCP port to avoid conflicts. To change this port click on **albpengine ➤ Engine Nodes ➤ [your_node_host]** and change the **Port** field.

4. Verify that the Process Portal Community is correctly configured.
   a) Click the **My Communities** drop-down option
   b) Select **Process Community**.

   The Oracle BPM WorkSpace appears in the main Portal window.
Configuring Oracle BPM Supporting Applications

The following sections describe how to install and configure Oracle BPM Enterprise supporting applications.

Process Instance Archiving
Oracle BPM allows you to archive information about completed or aborted process instances. After user-specified duration, instance information is moved from the engine database to the archive database. You can use the Archive Viewer application to view instance data once it has been moved to the archive database.

Archiving and Deployment
You must enable archiving when deploying a project to collect all information about the project.

When deploying a project, you can configure the following archiving options:

- Enable archiving
- Archive attachments
- Archive notes

If archiving is enabled globally in Process Administrator, but you do not enable archiving during deployment, old process instances are not archived. You must re-deploy the project to enable archiving. This redeployment requires a project version change.

Configuring Archiving
The following high-level task shows you how to configure process instance archiving, including creating the archive database and enabling archiving using Process Administrator.

1. Create an external resource for the archive database.
2. Enable archiving
   
   Process instance archiving is not enabled by default. You must enable archiving before you can create the archive database.
   
   See Enabling Archiving on page 46 for more information.
3. Create the archive database
   
   See Creating the Archive Database on page 47
4. Republish and redeploy your project
   
   If you have any projects that were previously published and deployed, you must republish and redeploy them before their process instances are archived.
5. View process instance archives with the Archive Viewer.
   
   Launching the Archive Viewer Application on page 47

Enabling Archiving

1. Launch Process Administrator.
2. Select Engine.
3. Select the engine where you want to enable archiving.
4. Select Services.
5. Click **Enable Archiving** under the **Disposer** section.
6. Select the external resource for your archive database.

   If you have not created an external resource for your archive database, click **Create a New Configuration**.

After you have enabled archiving, you can create the archive database using the **Manage Database** page under **Edit Engines**. See *Creating the Archive Database* on page 47.

**Creating the Archive Database**

Before performing the following procedures, ensure that you have enabled archiving. See *Enabling Archiving* on page 46 for more information. You should also ensure that you have created an external resource for your archive database server and specified this external resource on the **Services** tab. Process Administrator uses this external resource to connect to the archive database to create the required database tables.

1. Launch Process Administrator
2. Select the engine where you are creating the archive database.
   
   **Note:** You must create a separate archive database for each engine.

3. Select the **Basic Configuration** tab.
4. Select **Manage Database**.
5. Select **Create the archiving database** and **Create the archiving database structure**.
6. Enter the DBA username and password for your database server.
7. Click **OK** to create the archive database.

The archive database is created.

**Launching the Archive Viewer Application**

Before using the Archive Viewer to view process instance information, you must create an database configuration for the Archive Viewer.

1. Start the Admin Center.
2. Click **Configuration**.
3. Select **BPM Web Applications**.
4. Ensure that the Archive Viewer checkbox is enabled
5. Click **OK**.
6. Click **Start BPM Web Applications**.
7. Click **Launch Archive Viewer**.

The Archive Viewer application starts.

---

**BAM**

**BAM Overview**

Business Activity Monitoring (BAM) allows you to store, analyze, and display statistics about your business process execution.

BAM provides information about process instance performance and process workload. This information can be used to present almost real-time business processes metrics. You can then use these to analyze and then improve or adapt business processes based on real-world conditions.
To store and present this information, BAM contains the following:

| Database | BAM data is stored within a database. In Oracle BPM Studio, this information is stored internally as part of the embedded process execution engine database. In Oracle BPM Enterprise, you must configure an external database to function as the BAM database. |
| SQL Queries | You can write queries that access the information stored in the BAM database. These queries are contained within a BPM Object Method. When you create a BAM Dashboard using the wizard, the wizard automatically creates queries based on the type of Dashboard template you choose. You can customize these queries or create your own queries and dashboards to customize the way you present BAM. |
| BAM Dashboards | BAM Dashboards allow you to display BAM information in a meaningful and useful way. BAM Dashboards also allow you to drill down from a general view of a process to more specific information such as an order or claim. |

Note: BAM Dashboards require the Flash Plugin.

**BAM Database**
The BAM database is used to store information about your business processes.

The BAM database stores the following types of information about a process:

1. Workload
2. Task Performance
3. Process Performance

The following diagram shows the relationship between each of the BAM tables:
How BAM Database is Populated

BAM database is populated with the information generated by auditing events. Auditing events generation can be enabled for the whole process, for a subset of activities or for a particular activity. For more information on how to configure auditing events generation please see the Oracle BPM Enterprise Administration Guide and the Oracle BPM Studio User Guide.

Using Variables in BAM

When creating a Project variable, you can define it as a Business Indicator variable. This allows the variable to be stored in BAM the database.

When you add Business Indicator variable to your process, a column is added to the following BAM database tables: Workload, Task Performance and Process Performance. The name of this column is the Business Indicator name preceded by the prefix "V_".

If you define a business dimension, the workload table contains one row for each possible value of this business dimension present in the process. Each row shows the quantity of instances that match that business dimension. If the business dimension has a numeric type, the value stored in BAM tables indicates the range that corresponds to the value of the business dimension.

When you define a measurement business variable, the sum of this variable's value for all in flight instances is stored into workload table. If business dimensions were defined as well, then this sum will be divided into as many rows as business dimension values present in flight instances.

Task performance table stores one row for each instance that completes an activity. Each of these rows contains the value of dimensions and measurements at the time the instance completed the activity.

In a similar way, process performance table stores one row for each instance that gets to the end activity. Each of these rows contains the value of dimensions and measurements at the time the instance completed the whole process.
**BAM Database Reference**  
The BAM database has a star shaped style schema. This reference describes the fact tables and dimension tables in the BAM database.

**Fact Tables:**
- BAM_WORKLOAD
- BAM_TASK_PERFORMANCE
- BAM_PROCESS_PERFORMANCE

**Dimension Tables:**
- BAM_OUS
- BAM_ROLES
- BAM_PARTICIPANTS
- BAM_PROCESSES
- BAM_ACTIVITIES

**BAM_WORKLOAD**  
This table contains information about the work items in process. The BAM Updater populates this table with the information it obtains periodically from the engine.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>snapshot</td>
<td>TIMESTAMP</td>
<td>NOT NULL</td>
<td>The date and time of the snapshot this row belongs to.</td>
</tr>
<tr>
<td>activityIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the activity where the work items this row represents, are sitting in. Use this IN in join queries against the BAM_ACTIVITIES table.</td>
</tr>
<tr>
<td>roleIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the role where the work items this row represents, are sitting in. Use this IN in join queries against the BAM_ROLES table.</td>
</tr>
<tr>
<td>participantIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the participant the work items this row represents, are assigned to. Use this IN in join queries against the BAM_PARTICIPANT table.</td>
</tr>
<tr>
<td>origActivityIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>If the work items this row represents, are sitting in a subflow activity, this field indicates the identification number of the activity in the subprocess associated to this subflow activity. Otherwise the value of this field is 1.</td>
</tr>
<tr>
<td>waitActivityIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>If the work items this row represents, are sitting in the sub-process of a subflow activity, this field indicates the identification number of the subflow activity in the parent process. Otherwise the value of this field is 1.</td>
</tr>
</tbody>
</table>
### Description

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| quantity   | DECIMAL(10) | NOT NULL  | Indicates the number of work items that match the value of the following fields in this row:  
  - processIn  
  - activityIn  
  - roleIn  
  - participantIn  
  - business dimension  
  - latsnapshot |
| avgTimeTask | DECIMAL(10) | NOT NULL  | The average waiting time (in seconds), that the instances represented by this row, spent in the activity at the moment of the snapshot. |
| meanTimeTask | DECIMAL(10) | NOT NULL  | The median of the waiting time (in seconds), that the instances represented by this row, spent in the activity at the moment of the snapshot. |
| avgTimeProcess | DECIMAL(10) | NOT NULL  | The average waiting time (in seconds), that the instances represented by this row, spent in the process at the moment of the snapshot. |
| meanTimeProcess | DECIMAL(10) | NOT NULL  | The median of the waiting time (in seconds), that the instances represented by this row, spent in the process at the moment of the snapshot. |

**Primary Key:** The primary key constraint is not defined in the database schema. The BAM Updater checks this constraint.

The following fields form the primary key:

- activityIn
- processIn
- roleIn
- participantIn
- snapshotTime
- Business Dimensions

**Foreign Keys**

<table>
<thead>
<tr>
<th>Foreign Key</th>
<th>Referenced Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityIn</td>
<td>BAM_ACTIVITIES</td>
</tr>
<tr>
<td>waitActivityIn</td>
<td>BAM_ACTIVITIES</td>
</tr>
<tr>
<td>origActivityIn</td>
<td>BAM_ACTIVITIES</td>
</tr>
<tr>
<td>roleIn</td>
<td>BAM_ROLES</td>
</tr>
<tr>
<td>participantIn</td>
<td>BAM_PARTICIPANTS</td>
</tr>
</tbody>
</table>
**BAM_TASKPERFORMANCE**

This table contains performance information for every work item that has completed an activity.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the completed activity. Use this IN in join queries against the BAM_ACTIVITIES table.</td>
</tr>
<tr>
<td>roleIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the role the completed activity is assigned to. Use this IN in join queries against the BAM_ROLES table.</td>
</tr>
<tr>
<td>participantIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the participant the completed activity is assigned to. Use this IN in join queries against the BAM_ROLES table.</td>
</tr>
<tr>
<td>completionDate</td>
<td>TIMESTAMP</td>
<td>NOT NULL</td>
<td>The time when the work item completed the activity. This time is stored in GMT-0.</td>
</tr>
<tr>
<td>taskTime</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The time (in seconds) the work item took to complete the activity.</td>
</tr>
<tr>
<td>idleTime</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The time the work item waited until its first execution.</td>
</tr>
</tbody>
</table>

**Foreign Keys**

<table>
<thead>
<tr>
<th>Foreign Key</th>
<th>Referenced Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityIn</td>
<td>BAM_ACTIVITIES</td>
</tr>
<tr>
<td>roleIn</td>
<td>BAM_ROLES</td>
</tr>
<tr>
<td>participantIn</td>
<td>BAM_PARTICIPANTS</td>
</tr>
</tbody>
</table>

**BAM_PROCESSPERFORMANCE**

This table contains performance information for every work item that has completed the whole process.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>processIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the process. This number identifies the process in the organizational unit. It may vary between deployments. Use the IN only for join queries with other tables. Do not use the IN directly in your queries, instead use the processID.</td>
</tr>
<tr>
<td>completionDate</td>
<td>TIMESTAMP</td>
<td>NOT NULL</td>
<td>The time when the work item completed the process. This time is stored in GMT-0.</td>
</tr>
<tr>
<td>taskTime</td>
<td>TIMESTAMP</td>
<td>NOT NULL</td>
<td>The time (in seconds) the work item took to complete the activity.</td>
</tr>
</tbody>
</table>

**Foreign Keys**
### Foreign Key

<table>
<thead>
<tr>
<th>Referenced Table</th>
<th>ProcessIn</th>
</tr>
</thead>
<tbody>
<tr>
<td>BAM_PROCESSES</td>
<td></td>
</tr>
</tbody>
</table>

### BAM_LASTSNAPSHOT

This table stores the time when the BAM Updater took the last snapshot. The BAM Updater populates the Workload with the data obtained in each snapshot.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lastsnapshot</td>
<td>TIMESTAMP</td>
<td>NOT NULL</td>
<td>The time of the last snapshot. Use this time to obtain from the Workload table the rows that correspond to the most up-to-date data.</td>
</tr>
</tbody>
</table>

### BAM_OUS

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>Nullable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ouIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the organizational unit. This number identifies the organizational unit in its parent organizational unit. It may vary between deployments. Use the IN only for join queries with other tables. Do not use it directly in your queries, instead use the name.</td>
</tr>
<tr>
<td>parentIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the parent organizational unit. If this row corresponds to the Organization the value of this field is -1.</td>
</tr>
<tr>
<td>name</td>
<td>STRING(255)</td>
<td>NOT NULL</td>
<td>The name of the organizational unit. Use this ID in where clauses to restrict the query to a certain role.</td>
</tr>
<tr>
<td>fullPathName</td>
<td>STRING(512)</td>
<td>NOT NULL</td>
<td>The complete name of the organizational unit, which includes the complete name of its parent organizational unit.</td>
</tr>
</tbody>
</table>

**Primary Key:** ouIn

### BAM_ROLES

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>Nullable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>roleIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the role. This number identifies the role in the organizational unit. It may vary between deployments. Use the IN only for join queries with other tables. Do not use the IN directly in your queries, instead use the roleID.</td>
</tr>
<tr>
<td>roleID</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The ID that identifies the role in the organizational unit. Use this ID in where</td>
</tr>
</tbody>
</table>
### Field Name | Value | NULL Value | Description
---|---|---|---
| | | | clauses to restrict the query to a certain role.

**Primary Key:** roleIn

### BAM_PARTICIPANTS

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>participantIN</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the participant. This number identifies the participant in the organizational unit. It may vary between deployments. Use the IN only for join queries with other tables. Do not use the IN directly in your queries, instead use the participantID.</td>
</tr>
<tr>
<td>participantID</td>
<td>STRING(255)</td>
<td>NOT NULL</td>
<td>The ID that identifies the participant in the organizational unit. Use this ID in where clauses to restrict the query to a certain participant.</td>
</tr>
<tr>
<td>ouIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the organizational unit the participant belongs to. Do not use this number directly in your queries, use it only for join queries against the BAM_OU table.</td>
</tr>
<tr>
<td>displayName</td>
<td>STRING(255)</td>
<td></td>
<td>The localized, human readable name of the organizational unit. The system locale settings of the environment where the BAM Updater runs determine the localization of this field.</td>
</tr>
</tbody>
</table>

**Primary Key:** participantIn

**Foreign Keys**

<table>
<thead>
<tr>
<th>Foreign Key</th>
<th>Referenced Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>ouIn</td>
<td>BAM_OU</td>
</tr>
</tbody>
</table>

### BAM_PROCESSES

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ouIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the organizational unit where the process is deployed. Do not use this number directly in your queries, use it only for join queries against the BAM_OU table.</td>
</tr>
<tr>
<td>processIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the process. This number identifies the process in the organizational unit. It may vary between deployments. Use the IN only for join queries with other tables. Do not use</td>
</tr>
</tbody>
</table>
### BAM_PROCESSES

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>processId</td>
<td>STRING(255)</td>
<td>NOT NULL</td>
<td>The ID that identifies the process in the organizational unit. Use this ID in where clauses to restrict the query to a certain process.</td>
</tr>
<tr>
<td>label</td>
<td>STRING(255)</td>
<td>NOT NULL</td>
<td>The localized, human readable name of the process. The system locale settings of the environment where the BAM Updater runs determine the localization of this field.</td>
</tr>
</tbody>
</table>

**Primary Key:** processIn.

**Foreign Keys**

<table>
<thead>
<tr>
<th>Foreign Key</th>
<th>Referenced Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>ouIn</td>
<td>BAM_OUS</td>
</tr>
</tbody>
</table>

### BAM_ACTIVITIES

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
<th>NULL Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activityIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of this activity. This number identifies the activity in the organizational unit. It may vary between deployments. Use the IN only for join queries with other tables. Do not use the IN directly in your queries, use the activityID.</td>
</tr>
<tr>
<td>activityId</td>
<td>STRING(255)</td>
<td>NOT NULL</td>
<td>The ID that identifies the activity in the organizational unit. Use this ID in where clauses to restrict the query to a certain activity.</td>
</tr>
<tr>
<td>processIn</td>
<td>DECIMAL(10)</td>
<td>NOT NULL</td>
<td>The identification number (IN) of the process this activity belongs to. Do not use this number directly in your queries, use it only for join queries against the BAM_PROCESSES table.</td>
</tr>
<tr>
<td>label</td>
<td>STRING(255)</td>
<td></td>
<td>The localized, human readable name of the activity. The system locale settings of the environment where the BAM Updater runs determine the localization of this field.</td>
</tr>
</tbody>
</table>

**Primary Key:** activityIn.

**Foreign Keys**

<table>
<thead>
<tr>
<th>Foreign Key</th>
<th>Referenced Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>processIn</td>
<td>BAM_PROCESSES</td>
</tr>
</tbody>
</table>
Configuring BAM
The following high-level task outlines the procedures for configuring BAM on Oracle BPM Enterprise.
To configure BAM:

1. Log in to Oracle BPM Process Administrator.
2. Create an External Resource of type SQL to connect to the database where you want to store BAM data.
3. Configure BAM following the procedure described in Configuring BAM on page 56.
4. Create the BAM database following the procedure described in Creating the BAM Database on page 56.
5. Start the Process Monitoring Service following the procedure described in Starting the Process Monitoring Service on page 58.

Note: If you are running Oracle BPM in a J2EE environment you must re-create and re-install the Engine ear file. For more information on how to do this, see Building and Deploying Application EAR Files on page 32.

Configuring BAM
The following procedures shows you how to configure BAM on Oracle BPM Enterprise.

Before following this procedure you must create an External Resource of type SQL to connect to the database you selected to store BAM data.

To configure BAM:

1. Select the Process Monitoring node.
2. Select the BAM tab.
4. Select the External Resource you created for BAM, from the Updater Database Configuration drop-down list.
5. Click Save.

Oracle BPM Process Administrator stores the new BAM configuration.

Creating the BAM Database
The following procedure shows you how to create the BAM Database.

Before following this procedure you must configure BAM settings.

To create the BAM Database

1. Select the Process Monitoring node.
2. Select the BAM tab.
3. In the Advanced Properties section, click Manage Database.
4. Select the Create the database check-box.
5. Select the Create the data structure check-box.
6. Enter the database administrator user in the Database Administrator User field.
7. Enter the database administrator password in the Database Administrator Password.
8. Click OK.

A message informing the database and the data structure were created appears.

Starting the Process Monitoring Service
The Process Monitoring Service works with the process execution engine to store instance data in the Process Data Mart and BAM databases. Both BAM and Process Data Mart use the same service.
The Process Monitoring Service runs as an operating system service and is started separately from Oracle BPM Enterprise. It is supported on Windows and UNIX.

1. **Install the Process Monitoring Service (Windows)**
   - If you are running the Process Monitoring Service on Windows, install the service as follows:
     a) Run `<ORABPM_HOME>/bin/oraclebpmwarehouse.bat install`
        This command installs the Windows service.
     b) Ensure that the `JAVA_HOME` environment variable is set.

2. **Start the Process Monitoring Service**
   - On Windows, you can start the Oracle BPM 10.3 DataWarehouse Service as a normal Windows Service.
   - On UNIX, run `<ORABPM_HOME>/bin/oraclebpmwarehouse.sh start`

**Process Data Mart Overview**

Oracle BPM Process Data Mart allows to store historical process monitoring information.

The Process Data Mart and BAM database store the same information. The information in the Process Data Mart is more consolidated and it stores it for longer periods of time.

You can use the data in the Process Data Mart to contextualize BAM data.

The Process Data Mart database and BAM database share the same schema definition. The only difference is that the tables in the BAM database start with the "BAM_" suffix. This allows use to easily re-use the SQL queries you define for BAM.

**Configuring Process Data Mart**

The following high-level task outlines the procedures for configuring Process Data Mart on Oracle BPM Enterprise.

To configure the Process Data Mart:

1. Log in to Oracle BPM Process Administrator.
2. Create an External Resource of type SQL to connect to the database where you want to store Process Data Mart data.
3. Configure the Process Data Mart following the procedure described in *Configuring Process Data Mart* on page 57.
4. Create the BAM database following the procedure described in *Configuring the Process Data Mart Database* on page 58.
5. Start the Process Monitoring Service following the procedure described in *Starting the Process Monitoring Service* on page 58.

**Note:** If you are running Oracle BPM in a J2EE environment you must re-create and re-install the Engine ear file. For more information on how to do this, see *Building and Deploying Application EAR Files* on page 32.

**Configuring Process Data Mart**

The following procedures shows you how to configure the Process Data Mart on Oracle BPM Enterprise.

Before following this procedure you must create an External Resource of type SQL to connect to the database you selected to store Process Data Mart data.

To configure the Process Data Mart:

1. Select the **Process Monitoring** node.
2. Select the **Process Data Mart** tab.
3. Select **Enable Automatic Update**.
4. Select the External Resource you created for the Process Data Mart, from the **Runtime Database Configuration** drop-down list.
5. Click **Save**.

Oracle BPM Process Administrator stores the new Process Data Mart configuration.

**Configuring the Process Data Mart Database**
The following procedure shows you how to create the Process Data Mart Database.

Before following this procedure you must configure Process Data Mart settings.

To create the Process Data Mart Database

1. Select the **Process Monitoring** node.
2. Select the **Process Data Mart** tab.
3. In the **Advanced Properties** section, click **Manage Database**.
4. Select the **Create the database** check-box.
5. Select the **Create the data structure** check-box.
6. Enter the database administrator user in the **Database Administrator User** field.
7. Enter the database administrator password in the **Database Administrator Password**.
8. Click **OK**.

A message informing the database and the data structure were created appears.

**Starting the Process Monitoring Service**
The Process Monitoring Service works with the process execution engine to store instance data in the Process Data Mart and BAM databases. Both BAM and Process Data Mart use the same service.

The Process Monitoring Service runs as an operating system service and is started separately from Oracle BPM Enterprise. It is supported on Windows and UNIX.

1. Install the Process Monitoring Service (Windows)
   
   If you are running the Process Monitoring Service on Windows, install the service as follows:
   a) Run `<ORABPM_HOME>/bin/oraclebpmwarehouse.bat install`
      This command installs the Windows service.
   b) Ensure that the `JAVA_HOME` environment variable is set.

2. Start the Process Monitoring Service

   • On Windows, you can start the Oracle BPM 10.3 DataWarehouse Service as a normal Windows Service.
   • On UNIX, run `<ORABPM_HOME>/bin/oraclebpmwarehouse.sh start`

**Configuring WorkSpace Across Multiple Domains**

You can deploy WorkSpace, or any PAPI application, in a separate domain than the domain where the Oracle BPM engine is running. This is often necessary in an environment where you want to physically isolate the WorkSpace application from the Process Execution Engine.

After you have configured your domain environment, you must perform the following additional configuration tasks:

1. Create a JDBC Datasource.
This datasource is used to connect to the directory database for the process execution engine. This datasource should be created on the domain where WorkSpace is deployed.

2. Enable Domain Trust.
   To allow the WorkSpace application to communicate with the domain of the process execution engine, you must allow trust between the two domains.

3. Create Foreign JNDI Provider.
   You must create and configure a foreign JNDI provider on the domain where the WorkSpace application is deployed.
   a) Launch the Oracle WebLogic Server Administration Console.
   b) Select Lock and Edit.
   c) Expand Services.
   d) Select Foreign JNDI Providers.
   e) Click New.
   f) Provide a name for the foreign JNDI provider, then click OK.
   The new foreign JNDI provider appears in the list of available providers. You must configure the foreign JNDI provider and create links between domain resources as outline in the following task.

4. Configure the Foreign JNDI Provider.
   a) Expand Services.
   b) Select Foreign JNDI Providers.
   c) Select the foreign JNDI provider created in the previous step.
   d) Click the Configuration tab, then click General
   e) Enter a value for the Initial Context Factory.
      This should be something like: weblogic.jndi.WLInitialContextFactory. The exact value depends on the JNDI provider and vendor you are using.
   f) Enter a value for the Provider URL.
      For example, t3://hostname: port
   g) Click Save.
   h) Click Links.
   i) Create the JNDI links.
      You must create the following four JNDI links:

      | Local JNDI Name                     | Remote JNDI Name                     |
      |------------------------------------|-------------------------------------|
      | /engines/ engine_name              | /engines/ engine_name               |
      | /processes/engine-engine_name/EJBProcessControl | /processes/engine-engine_name/EJBProcessControl |
      | XATopicConnectionFactory           | XATopicConnectionFactory            |
      | topic/EngineNews                   | topic/EngineNews                    |

   Note: The value for engine_name corresponds to the process execution engine you are configuring. XATopicConnectionFactory and topic/EngineNews correspond to the value of the JMS topics defined in Process Administrator.
The following sections contain general information about Oracle BPM Enterprise configuration.

**Engine and Directory Database Connectivity**

The following connectivity properties are required when configuring Oracle BPM Enterprise.

These connectivity properties are used when configuring JDBC drivers and directory services. They are used to connect to the following databases:

- Engine Database
- Directory Database
- BAM Database
- Archive Database

**Oracle Driver Properties**

You can specify the following connectivity properties for your Oracle database:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic</strong></td>
<td></td>
</tr>
<tr>
<td>Host</td>
<td>Specifies the hostname or IP address of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the Oracle listener running on the Oracle database server. The default is 1521, which is the Oracle default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Specifies the case-insensitive default user name used to connect to your Oracle database.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies the case-insensitive password used to connect to your Oracle database.</td>
</tr>
<tr>
<td>SID</td>
<td>Specifies the Oracle System Identifier that refers to the instance of the Oracle database running on the server.</td>
</tr>
<tr>
<td>Schema (optional)</td>
<td>Specifies the schema of the Oracle database server.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL used to connect to your database.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advanced</strong></td>
<td></td>
</tr>
<tr>
<td>Tablespace</td>
<td>Specifies the tablespace Oracle BPM uses to create new tables.</td>
</tr>
<tr>
<td>Temporary Tablespace</td>
<td>Specifies the temporary tablespace Oracle BPM uses to create new tables.</td>
</tr>
</tbody>
</table>
DescriptionProperty
Specifies the profile Oracle BPM assigns to the users it creates.

Use TimeStamp for Date Columns
Specifies if a column of type Date stores the date and the time. If unselected it only stores the date.

Properties
You can define name/value pairs to provide additional configuration properties to your database. See your vendor's documentation for more information.

Note: Connection property names are case-insensitive.

Runtime

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Determines the maximum number of connections that can be created within the connection pool.</td>
</tr>
<tr>
<td>Maximum Connections Per User</td>
<td>Determines the maximum number of connections that can be created per user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies the maximum time, in minutes, that a database connection can remain idle before it is closed automatically.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Determines the minimum number of connections that can be created within a connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Determines the maximum number of cursors that can be opened at one time.</td>
</tr>
</tbody>
</table>

Oracle DB2 Driver Properties
You can specify the following connectivity properties for your DB2 database:

Basic

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies the database server host.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port of the database host.</td>
</tr>
<tr>
<td>User</td>
<td>Defines user ID you want to use to connect to the database. This user must already exist in DB2 and have permissions to create the schema and tables used to store information.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies password for the user.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies the database you wish to connect to.</td>
</tr>
<tr>
<td>Schema</td>
<td>Specifies the database schema to use. (optional)</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL for the database entry.</td>
</tr>
</tbody>
</table>
Properties

You can define name/value pairs to provide additional configuration properties to your database. See your vendor’s documentation for more information.

**Note:** Connection property names are case-insensitive.

### Runtime

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Determines the maximum number of connections that can be created within the connection pool.</td>
</tr>
<tr>
<td>Maximum Connections Per User</td>
<td>Determines the maximum number of connections that can be created per user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies the maximum time, in minutes, that a database connection can remain idle before it is closed automatically.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Determines the minimum number of connections that can be created within a connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Determines the maximum number of cursors that can be opened at one time.</td>
</tr>
</tbody>
</table>

### Oracle SQL Server Driver Properties

You can specify the following connectivity properties for your SQL Server database:

#### Basic

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies the hostname or IP address of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>The TCP port of the primary database server that is listening for connections to the Microsoft SQL Server database. The default is 1433.</td>
</tr>
<tr>
<td>User</td>
<td>Specifies the case-insensitive user name used to connect to your Microsoft SQL Server database.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies a case-insensitive password used to connect to your Microsoft SQL Server database.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies either the IP address or the server name, if your network supports named servers, of the primary database server.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format used to connect to your database.</td>
</tr>
</tbody>
</table>

Properties

You can define name/value pairs to provide additional configuration properties to your database. See your vendor’s documentation for more information.
Note: Connection property names are case-insensitive.

### Runtime

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Determines the maximum number of connections that can be created within the connection pool.</td>
</tr>
<tr>
<td>Maximum Connections Per User</td>
<td>Determines the maximum number of connections that can be created per user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies the maximum time, in minutes, that a database connection can remain idle before it is closed automatically.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Determines the minimum number of connections that can be created within a connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Determines the maximum number of cursors that can be opened at one time.</td>
</tr>
</tbody>
</table>

### Oracle Sybase Driver Properties

You can specify the following connectivity properties for your Sybase database:

#### Basic

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies the hostname or IP address of the Sybase database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the Sybase listener running on the Sybase database server. The default is 2048, which is the Sybase default port number when installing the Sybase database software.</td>
</tr>
<tr>
<td>User</td>
<td>Specifies the case-sensitive default user name used to connect to your Sybase database.</td>
</tr>
<tr>
<td>Password</td>
<td>Specifies the case-sensitive password used to connect to your Sybase database.</td>
</tr>
<tr>
<td>Database</td>
<td>The name of the database that contains the tables.</td>
</tr>
<tr>
<td>Device</td>
<td>The device where tables are created.</td>
</tr>
<tr>
<td>Allocation Size</td>
<td>The amount of space to allocate to the database extension.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL to connect to your Sybase database. You cannot edit this field directly, the URL is formed using the host and database you define.</td>
</tr>
</tbody>
</table>

### Properties Tab

The Properties tab allows you to define name/value pairs to configure database properties.

Note: All connection property names are case-insensitive.
Runtime Tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Determines the maximum number of connections that can be created within the connection pool.</td>
</tr>
<tr>
<td>Maximum Connections Per User</td>
<td>Determines the maximum number of connections that can be created per user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies the maximum time, in minutes, that a database connection can remain idle before it is closed automatically.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Determines the minimum number of connections that can be created within a connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Determines the maximum number of cursors that can be opened at one time.</td>
</tr>
</tbody>
</table>

Oracle BPM Configuration Wizard Reference

The following topics provide general information about the Oracle BPM Configuration Wizard. They also provide screen-by-screen reference information for each field.

Oracle BPM Configuration Wizard Overview

The Oracle BPM Configuration Wizard provides a convenient way of configuring Oracle BPM Enterprise. You can use the Configuration Wizard to create either a Standalone or WebLogic Server environment. The following sections describe the tasks that can be performed.

Create the Directory and Engine Databases

You can use the Configuration Wizard to create a new Directory and Engine Database. In order to create these databases, you must supply the DBA username and password for your database. If you do not have permission to access your database server, you can use the Configuration Wizard to generate the required SQL scripts. Your database administrator can use these scripts to create the required databases.

When configuring the directory database, you can select whether to create a database-only or hybrid directory service. The hybrid directory service allows you to use an LDAP server to provide organizational information.

Tip: When configuring a hybrid directory service, you must install and configure your LDAP server before running the Configuration Wizard.

Publish and Deploy a Sample Project

The Configuration Wizard can create and deploy a sample project. You can use this sample project to verify that your Oracle BPM Enterprise installation is configured correctly.

When you choose to perform this option, the Configuration Wizard creates a new process execution engine and creates external resources that point to the engine and directory databases.

Configure the Oracle WebLogic Server Environment

You can use the Configuration Wizard to create and configure a basic Oracle BPM installation on WebLogic Server. You can use the Configuration Wizard to quickly create a test environment.
However, the Configuration Wizard cannot be used to create clustered or multi-domain environments. For production environments, you should use the manual configuration procedures outlined in the Oracle BPM Configuration Guide.

When using the Oracle BPM Configuration Wizard, you can select to perform the following:

- Create a new WebLogic Server domain or install into an existing WebLogic Server domain.
- Deploy the Oracle BPM applications to a managed server.

The configuration wizard creates all of the necessary JDBC and JMS resources.

### Running the Oracle BPM Configuration Wizard

The following procedures show you how to use the Configuration Wizard. The exact path depends on the options you choose.

1. Determine what tasks you want the configuration Wizard to perform.
   This allows you to define the tasks performed. See Configuration Wizard Tasks on page 66.
2. Determine if you want to use a database only or a hybrid.
   See Directory Provider Type on page 66.
3. Enter information about your directory provider type.
   See Directory Provider Selection on page 67. If you have chosen to implement the
4. Enter connectivity information about your database.
   Provider | More information
   Oracle | Configure Directory Provider - Oracle on page 68
   DB2 | Configure Directory Provider - DB2 on page 69
   SQL Server | Configure Directory Provider - SQL Server on page 70
5. Enter connectivity information for you external organization provider.
   - Note: This page appears only when you have chosen to configure an external directory service for
   your organizational data.
6. Enter one of the following:
   - If you have selected to have the Configuration Wizard create the database, provide information DBA
     username and password.
   - If you have selected to generate SQL script, enter org log name.
7. If you have selected to generate SQL scripts, you can choose to save it as a file or you can copy and paste
   it to a file.
8. Select the type of database you want to use for your Process Execution Engine database
9. Enter connectivity information for you Process Execution Engine database
10. If you have selected to have the Configuration Wizard create the database, provide information DBA
    username and password.
11. If you have selected to generate SQL scripts, you can choose to save it as a file or you can copy and paste
    it to a file.
12. Select the EAR files you want to create and deploy (WebLogic Server)
13. Provide connectivity information for your WebLogic Server Installation
Running the Configuration Wizard Silently

You can run the Configuration Wizard silently using a configuration file to supply the parameters. This file can be edited manually, or it can be generated after running the wizard.

To run the Configuration Wizard silently, you must run it from the command line version with the --silent option. You must also supply the path to an existing configuration template. The following examples show the syntax:

1. Linux: `obpmconfigwizard configuration_file.template --silent`.

Note: The Configuration Wizard does not validate the format of the template. If you edit the configuration template by hand, you must ensure that it is valid before running the Configuration Wizard.

Oracle BPM Configuration Wizard Reference

The following topics provide detailed information for each page of the Configuration Wizard.

Configuration Wizard Tasks

The Configuration Tasks page allows you to specify the tasks performed by the Configuration Wizard.

You can determine which of these the Configuration Wizard performs by selecting from the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Directory Service</td>
<td>Allows you to create a new Oracle BPM Directory Service</td>
</tr>
<tr>
<td>Use Existing Directory Service</td>
<td>Allows you to use an existing Oracle BPM Directory Service.</td>
</tr>
<tr>
<td></td>
<td>Note: If you choose to use an existing directory service, it must be created using the current version of Oracle BPM.</td>
</tr>
<tr>
<td>Generate Directory Service SQL Script only</td>
<td>Generates a SQL script that can be used to configure the database server and schema. Use this option if you do not have DBA permissions on the database. The generated scripts can be used by your DBA.</td>
</tr>
<tr>
<td>Create Process Engine</td>
<td>Allows you to create the Process Execution Engine database using the Configuration Wizard.</td>
</tr>
<tr>
<td>Generate Process Engine SQL Script only</td>
<td>Generates a SQL script that can be used to configure the database server and schema. Use this option if you do not have DBA permissions on the database. The generated scripts can be used by your DBA.</td>
</tr>
<tr>
<td>Publish and Deploy Sample Project</td>
<td>Allows the Configuration Wizard to publish and deploy BPM sample projects. This option is only available if you select to create the Process Execution Engine database.</td>
</tr>
<tr>
<td>Load Template</td>
<td>Allows you to load a Configuration Wizard template to automatically populate the fields of the configuration wizard.</td>
</tr>
<tr>
<td>Create Oracle BPM Applications EAR Files (WLS)</td>
<td>Generates the EAR files for each Oracle BPM Enterprise application.</td>
</tr>
<tr>
<td>Oracle WebLogic Configuration (WLS)</td>
<td>Configures WebLogic Server and deploys the Oracle BPM Enterprise applications.</td>
</tr>
</tbody>
</table>

Directory Provider Type

This page allows you to specify how the directory provider is configured.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use a database managed by Oracle BPM</td>
<td>Creates a database-only directory service. You must create your organizational structure using the Process Administrator.</td>
</tr>
<tr>
<td>Use an external directory service provider plus a database managed by Oracle BPM</td>
<td>Creates a hybrid directory service using a database and an external directory service such as LDAP to manage your organizational structure.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When integrating Oracle Interaction, you must choose this option to select the Oracle Interaction Identity Service (Hydrogen).</td>
</tr>
</tbody>
</table>

**Directory Provider Selection**

This page allows you to define general information about the Oracle BPM directory configuration including the database type and the Oracle BPM administrator user ID and password.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Configuration Name</td>
<td>Specifies the name used to refer to this configuration within Admin Center.</td>
</tr>
<tr>
<td>Description</td>
<td>Provides a useful description for the new directory service configuration.</td>
</tr>
<tr>
<td>Directory Provider</td>
<td>Specifies the database driver for directory database.</td>
</tr>
<tr>
<td>Organization Provider</td>
<td>Defines the type of external directory service provider. This option only appears if you have chosen to configure a hybrid directory service.</td>
</tr>
<tr>
<td></td>
<td>The following options are available:</td>
</tr>
<tr>
<td></td>
<td>• Active Directory</td>
</tr>
<tr>
<td></td>
<td>• Generic JNDI</td>
</tr>
<tr>
<td></td>
<td>• Sample LDAP Service</td>
</tr>
<tr>
<td></td>
<td>• Sun One LDAP</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you are configuring WorkSpace Extensions, you must Generic JNDI as the Organization Provider.</td>
</tr>
<tr>
<td>BPM Administrator User</td>
<td>Defines the BPM Administrator user ID. This user ID is used to login to Process Administrator. The Configuration Wizard creates this new user ID in the database along with the associated permissions. However, if you are configuring a hybrid directory configuration using LDAP, this user must already exist in your LDAP organization.</td>
</tr>
<tr>
<td></td>
<td>See the <em>Oracle BPM Enterprise Administration Guide</em> for more information about the BPM Administrator user.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When configuring AquaLogic Interaction integration using WorkSpace Extensions, this administrator ID must also be defined in the AquaLogic Integration Portal.</td>
</tr>
</tbody>
</table>
### Configure Directory Provider - Oracle

#### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>SID</td>
<td>Specifies the Oracle System Identifier that refers to the instance of the Oracle database running on the server.</td>
</tr>
<tr>
<td>Schema</td>
<td>Optionally, specifies the name of the schema used.</td>
</tr>
<tr>
<td>Note:</td>
<td>When using a schema, it is recommended that the schema name and user name be the same.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

#### Advanced Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablespace</td>
<td>Specifies the tablespace within the Oracle BPM database.</td>
</tr>
<tr>
<td>Temporary Tablespace</td>
<td>Specifies the temporary tablespace within the Oracle BPM database.</td>
</tr>
<tr>
<td>Profile</td>
<td>Specifies the profile for the Oracle BPM database. Profiles are as a way to limit which users can connect to the database.</td>
</tr>
</tbody>
</table>

#### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

#### Runtime

Runtime properties define the JDBC connection handling for Oracle BPM components when running outside a J2EE (for example, WebLogic Server). When running within a J2EE container, database connectivity information is supplied by the container itself.

The following runtime configuration properties can be defined for this database:
Configure Directory Provider - DB2
This page defines the connection properties for the IBM DB2 directory database.

Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server. For example, 122.23.15.12 or BPMDatabase.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>Database</td>
<td>Defines the name of the database used for the Oracle BPM directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

Properties Tab
This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

Runtime
The following runtime configuration properties can be defined for this database:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>
These properties define the JDBC connection handling for Oracle BPM components when running outside a J2EE (for example, WebLogic Server). When running within a J2EE container, database connectivity information is supplied by the container itself.

**Configure Directory Provider - SQL Server**

**Basic Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port of the listener running on the database server.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies the name of the database.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

**Properties Tab**

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

**Runtime**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

**Configure Directory Provider - Sybase**

This page defines the connection properties for the Sybase directory database.

**Basic Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies the name of the database.</td>
</tr>
</tbody>
</table>
### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

### Runtime

Runtime properties define the JDBC connection handling for Oracle BPM components when running outside a J2EE (for example, WebLogic Server). When running within a J2EE container, database connectivity information is supplied by the container itself.

The following runtime configuration properties can be defined for this database:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

### Configure Organization Provider - Active Directory

#### Basic Tab

**Options**

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Context Factory</td>
<td>Specifies the JNDI class name that creates sessions with the directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Specifies the URL used to connect to the directory service.</td>
</tr>
<tr>
<td>Principal</td>
<td>Specifies the user id to connect to the directory service.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Specifies the password used to connect to the directory service.</td>
</tr>
</tbody>
</table>

**Properties**

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.
## Runtime Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

## Configure Organization Provider - Sun LDAP

### Basic Tab

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Context Factory</td>
<td>Specifies the JNDI class name that creates sessions with the directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Specifies the URL used to connect to the directory service.</td>
</tr>
<tr>
<td>Principal</td>
<td>Specifies the user id to connect to the directory service.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Specifies the password used to connect to the directory service.</td>
</tr>
</tbody>
</table>

### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

### Runtime Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>
Configure Organization Provider - Generic JNDI

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Context Factory</td>
<td>Specifies the JNDI class name that creates sessions with the directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Specifies the URL used to connect to the directory service.</td>
</tr>
<tr>
<td>Principal</td>
<td>Specifies the user id to connect to the directory service.</td>
</tr>
<tr>
<td>Credentials</td>
<td>Specifies the password used to connect to the directory service.</td>
</tr>
<tr>
<td>External Process</td>
<td></td>
</tr>
<tr>
<td>LDAP Directory Properties</td>
<td>Specifies the configuration file used to map between Oracle BPM organizational information and your LDAP provider. Oracle provides several generic templates for common LDAP providers including Novell and Tivoli. These are located in ORBPM_HOME/conf. For more information on creating custom configuration files see the Oracle BPM Administration Guide.</td>
</tr>
</tbody>
</table>

**Note:** If you are integrating Oracle BPM with AquaLogic Interaction, you must specify the configuration file provided by Oracle. This is located in ORBPM_HOME/conf/generic_aluidirectory.conf.

Enter Directory Creation Information

The page allows you to enter the database administrator username and password. The Configuration Wizard uses this information to connect to the database and create run the SQL scripts to create database schema.

**Note:** This page does not appear if you have chosen to generate SQL scripts.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBA User</td>
<td>Specifies the Database Administrator user id.</td>
</tr>
<tr>
<td>DBA Password</td>
<td>Specifies the Database Administrator password.</td>
</tr>
<tr>
<td>Organization Logical Name</td>
<td>Defines the organization logical name for this Oracle BPM environment. This symbolic name is used in contexts where processes in different environments communicate with each other.</td>
</tr>
<tr>
<td>Enable SSO (J2EE Only)</td>
<td>Causes the Configuration Wizard to add the required SSO information to the directory database. In addition to this option, you must enable SSO for each Oracle BPM application using the Admin Center. See the Oracle BPM Enterprise Administration Guide for more information.</td>
</tr>
</tbody>
</table>

Show SQL Script

The page displays the generated SQL scripts for the Oracle BPM directory database. This page is displayed only if you have chosen to generate a SQL script instead of having the Configuration Wizard connect to the database. The DBA of the directory service database can use the script to create the necessary tables and schema.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to clipboard</td>
<td>Allows you to copy the generated script to the clipboard.</td>
</tr>
</tbody>
</table>
### Process Engine Provider Selection

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Database Provider</td>
<td>Specifies the database vendor of you Process Engine database.</td>
</tr>
</tbody>
</table>

### Process Engine Provider - Oracle

#### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>SID</td>
<td>Specifies the Oracle System Identifier that refers to the instance of the Oracle database running on the server.</td>
</tr>
<tr>
<td>Schema</td>
<td>Optionally, specifies the name of the schema used.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When using a schema, it is recommended that the schema name and user name be the same.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

#### Advanced Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tablespace</td>
<td></td>
</tr>
<tr>
<td>Temporary Tablespace</td>
<td></td>
</tr>
<tr>
<td>Profile</td>
<td></td>
</tr>
</tbody>
</table>

### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

### Runtime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool. Database connections are grouped together within a connection pool to improve performance.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

**Process Engine Provider - DB2**

**Basic Tab**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server. For example, 122.23.15.12 or BPMDatabase.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 1521, which is the default port number when installing the Oracle database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>Database</td>
<td>Defines the name of the database used for the Oracle BPM directory service.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

**Properties**

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

**Runtime**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>
### Process Engine Provider - SQL Server

#### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port of the listener running on the database server.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database.</td>
</tr>
<tr>
<td>Database</td>
<td>Specifies the name of the database.</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

#### Properties

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

#### Runtime

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

### Process Engine Provider - Sybase

This page defines the connection properties for the Sybase directory database.

#### Basic Tab

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Specifies either the IP address or the hostname of the database server.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the TCP port of the listener running on the database server. The default is 2048, which is the default port number when installing the Sybase database software.</td>
</tr>
<tr>
<td>User</td>
<td>Defines the user id used to connect to the database.</td>
</tr>
<tr>
<td>Password</td>
<td>Defines the password for the user id used to connect to the database. This password is case-insensitive.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
</tr>
<tr>
<td>Device</td>
<td></td>
</tr>
<tr>
<td>Allocation Size</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>URL</td>
<td>Defines the URL format to connect to the database.</td>
</tr>
</tbody>
</table>

**Properties**

This tab allows you to specify additional properties that are supported by the JDBC driver. Properties are defined using name/value pairs.

**Runtime**

Runtime properties define the JDBC connection handling for Oracle BPM components when running outside a J2EE (for example, WebLogic Server). When running within a J2EE container, database connectivity information is supplied by the container itself.

The following runtime configuration properties can be defined for this database:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Pool Size</td>
<td>Specifies the maximum number of connections within the connection pool.</td>
</tr>
<tr>
<td>Maximum connections per user</td>
<td>Specifies the maximum number of connections within the connection pool for each user.</td>
</tr>
<tr>
<td>Connection Idle Time (minutes)</td>
<td>Specifies how long a connection can be idle before it times out.</td>
</tr>
<tr>
<td>Minimum Pool Size</td>
<td>Specifies the minimum number of connections with the connection pool.</td>
</tr>
<tr>
<td>Maximum Opened Cursors</td>
<td>Specifies how many queries can be created for each connection.</td>
</tr>
</tbody>
</table>

**Process Engine Provider Configuration**

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DBA User</td>
<td>Specifies the Database Administrator user id.</td>
</tr>
<tr>
<td>DBA Password</td>
<td>Specifies the Database Administrator password.</td>
</tr>
<tr>
<td>Process Engine Name</td>
<td>Allows you to specify the name of the process engine the Configuration Wizard creates. This option is only available if you have chose to create and deploy a sample project.</td>
</tr>
<tr>
<td>Process Engine Home Folder</td>
<td>Specifies the home folder for the process execution engine.</td>
</tr>
</tbody>
</table>

**Show SQL Script**

This page displays the generated SQL script which is used by your database administrator to create the necessary tables and schema.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy to clipboard</td>
<td>Allows you to copy the generated script to the clipboard.</td>
</tr>
<tr>
<td>Save to file</td>
<td>Allows you to save the generated script to a file.</td>
</tr>
</tbody>
</table>
Ready to Execute
The Ready to Execute page allows you to save the information you have entered to a template file.

This file can be loaded into the Configuration Wizard automatically populate the fields the next time you run it. It can also be used as input when running the Configuration Wizard silently.

See Running the Configuration Wizard Silently on page 66

Select EAR Files to Create - WebLogic Server
This page allows you to select which application EAR files you want to create and deploy within your WebLogic Server installation.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EAR Files Folder</td>
<td>Specifies the directory where the generated WAR files are saved.</td>
</tr>
<tr>
<td>Process Engine EAR</td>
<td>EAR file for the Process Execution Engine</td>
</tr>
<tr>
<td>WorkSpace EAR</td>
<td>EAR file for the WorkSpace web application (for end users)</td>
</tr>
<tr>
<td>WorkSpace Administrator EAR</td>
<td>EAR file for the WorkSpace Admin web application (for Administrators)</td>
</tr>
<tr>
<td>RSS Feeds EAR</td>
<td>EAR file for the RSS Feeds web application (for end users to subscribe to their work lists)</td>
</tr>
<tr>
<td>Oracle Service Bus/Oracle BPM Transport EAR</td>
<td>EAR file for the optimized transport for Oracle Service Bus (formerly AquaLogic Service Bus)</td>
</tr>
</tbody>
</table>

Configure WebLogic Server

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create New Domain</td>
<td>Causes the configuration wizard to create a new WebLogic Server domain.</td>
</tr>
<tr>
<td>Modify an Existing Domain</td>
<td>Causes the configuration wizard to configure and deploy to an existing WebLogic Server domain.</td>
</tr>
<tr>
<td>Note: If you are using the configuration wizard to deploy to a clustered domain, you must select this option.</td>
<td></td>
</tr>
<tr>
<td>WebLogic Home</td>
<td>Specifies the root directory of your WebLogic Server installation.</td>
</tr>
<tr>
<td>Hostname</td>
<td>Specifies the hostname or IP address of the server where you want to deploy the Oracle BPM applications.</td>
</tr>
<tr>
<td>Port</td>
<td>Specifies the port number of the server where you want to deploy the Oracle BPM applications.</td>
</tr>
<tr>
<td>Server Name</td>
<td></td>
</tr>
<tr>
<td>Domain Name</td>
<td></td>
</tr>
</tbody>
</table>
### Configuring Oracle BPM

This page appears while the Oracle BPM Configuration Wizard is running. It may take several minutes for this to complete.

### Configuration Complete

This page appears after the Oracle BPM Configuration Wizard is complete. Click **Finish** to close the configuration wizard.

### Configuration Wizard Template File

```
########################################
# ALBPM Config Wizard template         #
########################################
@tasks-to-execute
  tasks=CreateDirectory,CreateEngine,PublishSample,CreateEARs,ConfigWeblogic

########################################
# Directory Configuration              #
########################################
@dir-config-begin
@dir-config-xml-begin
<?xml version="1.0" encoding="UTF-8"?>
<?fuego version="6.1 ALPHA" build="86554"?>
<DirectoryConfiguration>
  <id>default</id>
  <description>Default Directory Configuration</description>
  <admin>admin</admin>
  <adminPass><encrypted>gQ==</encrypted></adminPass>
  <presets>
    <preset name="engine">
      <property name="participant" value="admin"/>
      <property name="participant_password" value="<encrypted>gQ=="/>
    </preset>
    <preset name="xobjects">
      <property name="participant" value="admin"/>
      <property name="participant_password" value="<encrypted>gQ=="/>
    </preset>
    <preset name="portal-anonymous">
      <property name="participant" value="admin"/>
      <property name="participant_password" value="<encrypted>gQ=="/>
    </preset>
    <preset name="datawarehouse">
      <property name="participant" value="admin"/>
      <property name="participant_password" value="<encrypted>gQ=="/>
    </preset>
    <preset name="papiws-anonymous">
      <property name="participant" value="admin"/>
      <property name="participant_password" value="<encrypted>gQ=="/>
    </preset>
  </presets>
</DirectoryConfiguration>
```
<configuration name="fuego" type="SQL" subtype="DDORACLE">
<property name="jdbc.pool.idle_timeout" value="5"/>
<property name="jdbc.pool.entry.max" value="10"/>
<property name="oracle.dateEqualsTimestamp" value="false"/>
<property name="jdbc.host" value="homero"/>
<property name="user" value="ALBPMDir"/>
<property name="jdbc.port" value="1521"/>
<property name="jdbc.pool.min" value="0"/>
<property name="jdbc.pool.maxopencursors" value="100"/>
<property name="oracle.sid" value="ORCL"/>
<property name="password" value="<encrypted>gQ=="/>
<property name="jdbc.xa" value="false"/>
<property name="jdbc.pool.max" value="10"/>
</configuration>
</set>
</DirectoryConfiguration>
@dir-config-xml-end
directory.organization=bea
directory.description=Default Directory Configuration
directory.dba=system
directory.db.password=a
directory.enableSSO=false
@dir-config-end

# Engine Configuration
@engine-config-begin
@engine-config-xml-begin
<set>
<configuration name="albpmengine" type="SQL" subtype="DDORACLE">
<property name="jdbc.pool.idle_timeout" value="5"/>
<property name="jdbc.pool.entry.max" value="10"/>
<property name="oracle.dateEqualsTimestamp" value="false"/>
<property name="jdbc.host" value="homero"/>
<property name="jdbc.port" value="1521"/>
<property name="jdbc.pool.min" value="0"/>
<property name="jdbc.pool.maxopencursors" value="100"/>
<property name="oracle.sid" value="ORCL"/>
<property name="password" value="<encrypted>gQ=="/>
<property name="jdbc.xa" value="false"/>
<property name="jdbc.pool.max" value="10"/>
</configuration>
</set>
@engine-config-xml-end
directory.engine.name=albpmengine
directory.engine.dir=C:\fuego\trunk\local\dist\j2ee\engines
directory.engine.dba=system
directory.engine.db.password=a
@engine-config-end

# EARS to create
@ears-to-create-begin
earsToCreate=Engine,Feeds,PAPIWS,Workspace,WorkspaceAdmin
ears.folder=C:\fuego\trunk\local\dist\j2ee\ears
@ears-to-create-end

########################################
# EARs to create
########################################
@ears-to-create-end
# Weblogic Configuration

```
@wl-config-begin
weblogic.host=homero
weblogic.server=ALBPMServer
weblogic.dir=c:\bea\weblogic92
weblogic.domaindir=C:\bea\user_projects\domains
weblogic.domain=albpmaa
weblogic.password=a
weblogic.port=7001
weblogic.isrunning=false
@wl-config-end
```